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Computer System
Chapter 1

I.	 Tick	(√)	the	correct	option.	

1. Which among the following is not the characteristic of the computer?

 a. Diligence  b. Unlimited Memory

 c. Versatile  d. Accuracy

Ans.	 b. Unlimited Memory

2. The ALU stands for:

 a. Additional Logical Unit b. Asset Logical Unit

 c. Arithmetic Lexicographically Unit d. Arithmetic Logic Unit

Ans.	 d. Arithmetic Logic Unit

3. Which unit of the computer system is responsible for  holding the input data, intermediate 
results, output results and program and makes them available for processing as and when 
required?

 a. Input Unit  b. Internal Storage Unit

 c. Arithmetic Logic Unit d. Control Unit

Ans.		 b. Internal Storage Unit

4. The ________________ unit of the computer provides the capability of decision making to the 
computer.

 a. Input  b. Output

 c. Internal Storage  d. ALU

Ans.	 d.  ALU

5. Name the device that finds maximum usage in video conferencing and chatting in real time.

 a. Scanner  b. Digital Camera

 c. Web Camera  d. Video Camera

Ans.		 d. Video Camera

6. Name the printer whose print head contains banks of pins moving at high speed against inked 
ribbon and paper.

 a. Dot-Matrix Printer  b. Chain Printer

 c. Daisy Wheel Printer  d. None of these

Ans.		 a. Dot-Matrix Printer



3 Computer Applications – IX (CBSE Course) Answers

7. The _______________ printer is used to print images by selectively heating coated thermo 
chromic paper.

 a. Dot-Matrix Printer  b. Thermal Printer

 c. Ink-Jet Printer  d. Laser Printer

Ans.	 b. Thermal Printer

8. The contents of main memory, currently in use and likely to be needed in future is stored in 
which memory?

 a. Registers  b. Hard Disk

 c. Flash Memory  d. Cache Memory

Ans.	 d. Cache Memory

9. Which among the following secondary memories is not an Optical memory?

 a. Floppy  b. CD

 c. DVD  d. Blu-Ray

Ans.		 a. Floppy

10. Name the type of memory that is used in pen drive.

 a. Magnetic Disk Memory b. Optical Disk Memory

 c. Flash Memory  d. None of these

Ans.	 c. Flash Memory

II.	 Fill	in	the	blanks	with	the	given	words.

1. The term system refers to a group of interconnected components which work together to 
perform an integrated whole.  

2. Data are raw facts which when processed gives us Information.

3. The Output Unit is responsible for recording the final results sent from internal storage unit.

4. The Control Unit directs the operation of all components and units of the computer system as 
per the instructions given in a program.

5.  The ALU unit of the CPU is responsible for all arithmetic as well as logical operations.

6. The Scanner is an input device that captures information from a page and store them in graphic 
format.

7. The Laser printer uses toner to print images.

8. The Inkjet printer fires ink drops on paper for printing.

9. A webcam is a video camera that feeds or streams its image in real time to or through a computer 
to a computer network.

10. A block  is a sector or a group of sectors that the operating system can address in a hard disk.
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III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. Webcam can be used to record moving video with sound. T
2. The term “Versatile” used to define a characteristic of a computer that is used to  

tell that a computer can do different type of task. T
3. Processing of Information gives Data. F
4. The Input Unit of the Computer is responsible for holding input data and intermediate results. T
5. ROM is volatile in nature. F
6. The direction key on a keyboard is used to move the cursor on the screen. T
7. A mouse can have only one button. F
8. A Scanner is used to display data on the screen. F
9. Dot Matrix Printer is an example of an non- Impact Printer. F
10. Among all the memories, the Registers are the fastest memory. T

IV.	 Short	Answer	Type	Questions	(SA-I)

1. What	is	a	Computer	System?
Ans.	 Computer systems refers to a computer along with any software and peripheral devices that are 

necessary to make the computer perform a particular task.

2. What	is	the	function	of	an	ALU?
Ans.	 The Arithmetic Unit is responsible for performing arithmetic operations like addition, 

subtraction, multiplication and division. The Logical Unit is used to perform logic operations 
such as comparing, selecting, matching and merging of data.  

3. What	is	Flash	Memory	used	for?

Ans.	 Flash memory is a non-volatile memory chip used for storage and for transfering data between a 
personal computer (PC) and digital devices. It has the ability to be electronically reprogrammed 
and erased. It is often found in USB flash drives, MP3 players, digital cameras and solid-state 
drives.

4. What	is	‘block’	in	a	hard	disk?

Ans.	 A block is a sector or a group of sectors that the operating system can address (point to).

5. Name	the	type	of	memory	that	 is	placed	is	 logically	positioned	between	the	Registers	and	
Main	Memory.

Ans.		 Cache Memory

V.	 Short	Answer	Type	Questions	(SA-II)

1. How	does	a	Drum	Scanner	work?

Ans.		 Drum scanners spins the image at high speed while it is scanned pixel by pixel, creating the 
highest possible quality scanned image. Here the original document to be scanned is wrapped 
around a drum and then scanned by moving the detector head longitudinally as the drum is 
rotated.
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2. State	two	differences	between	a	RAM	and	a	ROM.
Ans.

Difference	between	RAM	and	ROM
RAM	(Random	Access	Memory) ROM	(Read	Only	Memory)

RAM is easily accessed by the processor. ROM can’t be directly accessed by the 
processor because first it is transferred into 
RAM where it is executed by the processor.

RAM is volatile in nature as it automatically 
erased when computer shutdowns.

ROM is non-volatile in nature as it never 
erased when there is any shutdown or restart 
of computer.

3. State	two	advantages	of	using	a	Dot	Matrix	Printer.

Ans.	 Advantages:

 a. It can print on multi-part stationery or make carbon-copies.

 b. Among all the printers it has the lowest printing costs per page.

4. State	two	disadvantages	of	using	a	Thermal	Printer.

Ans.	 Disadvantages	of	Thermal	Printers:

 a. Too much of heating is a possibility and may damage the printer.

 b. It is not suitable to print in colour.

5. What	is	a	Laser	Printer?		How	is	it	different	from	an	Inkjet	Printer?

Ans.	 A Laser printer is a type of printer that is linked to a computer producing good-quality printed 
material by using a laser to form a pattern of electrostatically charged dots on a light-sensitive 
drum, which attract toner (or dry ink powder). The toner is transferred to a piece of paper and 
fixed by a heating process. 

 Inkjet printer uses ink cartridges whereas laser printer uses toner cartridges.

6. What	 are	 the	 different	 types	 of	 memories	 that	 form	 the	Memory	 Unit	 of	 the	 Computer	
System?

Ans.	 RAM, ROM, Registers, Cache, Hard Disk, Memory Card, Pen drive, optical disk, etc.

7. Define	the	terms	“Block”	and	“Sector”	as	used	in	a	Hard	Disk.

Ans.		 A sector is one of the “pie slices” the diskette or disk is divided into. Dividing the circular medium 
into pie slices is a way to organize it so that data can be located by the read/write heads of the 
drive. The hard disk is usually installed inside the computer’s case, though there are removable 
and cartridge types as well. A block is a sector or a group of sectors that the operating system 
can address (point to). The bigger the hard disk size more the sectors that a block will hold.  It is 
the block where actual data is stored.

8. What	is	the	difference	between	CD	and	DVD?

Ans.	 DVDs offer more data storage capacity compared to CDs. CDs are also commonly used for audio 



Computer Applications – IX (CBSE Course) Answers 6

and program files, while DVDs are used for video and program files.

9. How	are	the	terms	Data	and	Information	related?

Ans.	 Data are simply facts or figures — bits of information, but not information itself. When data are 
processed, interpreted, organized, structured or presented so as to make them meaningful or 
useful, they are called information.

10. What	is	an	Input	Device?		Name	two	Input	Devices.

Ans.	 Input Devices are peripherals that are used to provide data to the computer system.  

 Example- Keyboard, Mouse, Scanner, etc.

VI.	 Long	Answer	Type	Questions	(LA)

1. Using	a	block	diagram	explain	how	data	is	processed	into	information	in	the	Computer	System.

Ans.	 The figure below shows the major components of a computer system.  It consists of an Input 
Unit, Central Processing Unit (CPU) and Output Unit.

Secondary/Auxillary	Memory

CPU

CONTROL	UNIT

INTERNAL	STORAGE	UNIT

ARITHMETIC	LOGIC	UNIT

INPUT	UNIT OUTPUT	UNIT

 Working	 of	 the	 components:	  It is through the “Input Unit” a computer receives data and 
instruction which get processed in the Central Processing Unit (CPU) and the result or information 
is shown through “Output Unit”.   While doing so the “Internal Storage Unit “ is responsible 
for holding the input data, intermediate results, output results and program and makes them 
available for processing as and when required.  In case the data, information or instruction 
needs to be stored permanently for future reference or even after the computer is turned off, 
the  “Secondary / Auxiliary Memory” is used.

2. Explain	the	concept	of	Block,	Sectors	and	Cylinder	of	a	Hard	Disk	with	the	help	of	a	diagram.

Ans.	 Hard Disk consists of 1 or more metal platters which are sealed inside a case. The metal platters 
attached to a spindle are magnetic in nature and stores data. Each platter requires two read/
write heads, one for each side. All the read/write heads are attached to a single access arm so 
that they cannot move independently. Each platter has the same number of tracks(they are like 
concentric rings), and a track location that cuts across all platters is called a cylinder.  A sector is 
one of the “pie slices” the diskette or disk is divided into. Dividing the circular medium into pie 
slices is a way to organize it so that data can be located by the read/write heads of the drive.  
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The hard disk is usually installed inside the computer’s case, though there are removable and 
cartridge types as well.   A block is a sector or a group of sectors that the operating system can 
address (point to). The bigger the hard disk size more the sectors that a block will hold.  It is the 
block where actual data is stored.

3. Describe	the	memory	hierarchies	of	a	computer	system.

Ans.	 The different types of memories that forms the Memory Unit of the Computer System  are:

 • CPU Registers • Cache Memory • Main Memory • Secondary Memory

4. How	is	a	Impact	printer	different	from	a	Non-Impact	printer?	Also	give	examples	of	both	these	
printers.

Ans.

Impact	Printers Non-impact	Printers

1.  It prints characters or images by 
striking print hammer or wheel against 
an inked ribbon.

1.  It prints characters and images without 
striking the papers.

2. Its speed is slower. 2. Its speed is faster.

3. Its printing quality is lower. 3. Its printing quality is higher.

4.  It normally uses continuous paper 
sheet.

4.  Its normally uses individual paper 
sheet.

5. It generates noise during printing. 5.  It does not generate noise during 
printing.

6. It uses inked ribbon for printing. 6. It uses toner or cartridge for painting.
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7. It is less expensive. 7. It is more expensive.

8. Dot matrix is an impact printer. 8. Laser printer is a non-impact printer.

5. Explain	how	printing	occurs	in	a	Laser	Printer.

Ans.	 It makes a laser beam scan back and forth across a drum inside the printer, building up a pattern 
of static electricity. The static electricity attracts onto the page a kind of powdered ink called 
toner. Finally, as in a photocopier, a fuser unit bonds the toner to the paper.

Application	based	Questions

1. Shamim	is	a	student	of	architectural	student	and	wants	to	design	a	building	using	his	computer.		
He	manages	to	draw	a	building	but	 is	unable	to	determine	what	type	of	printer	should	be	
used.		Suggest	him	a	suitable	printer	along	with	the	reason.

Ans.	 Shamim should go for a Plotter, this is because it has the following advantages for users of 
architecture.

• Plotters are able to work on large sheets(2 or more feet) of paper and still maintain high quality 
resolution at good speed.

• It can print on wide variety of materials such as sheet steel, plywood,  aluminum, plastic, 
cardboard and almost any flat sheet material.

• It is possible for plotters to save all patterns and templates on disk and eliminate the hassle of 
having to load the same patterns or templates over and over again. 

2. Anuska	is	a	video	editor	and	performs	video	editing	in	a	production	house.		The	files	she	stores	
are	usually	of	huge	sizes	approximately	of	30	GB.		The	company	plans	for	an	upgradation	and	
require	to	keep	backup.		Suggest	Anuska	an	Optical	Disk	that	will	help	her	in	keeping	backup,	
with	reasons.

Ans.	 As Video Editing requires huge amount of storage space for rendering movies, the best optical 
backup device would be to use Blu-Ray Disc.

3. Phantom	is	a	computer	programmer,	who	is	developing	a	small	software	for	a	retail	chain.	
Unfortunately,	the	shop	owner	is	not	able	to	provide	him	an	internet	connection;	Phantom	
carries	different	modules	of	this	software,	installs	in	the	computers	connected	in	various	shops	
and	carries	sample	data	back	with	him	for	testing.	Which	storage	device	will	you	suggest	to	
him	to	use	for	this	purpose?	This	device	should	have	high	storage	capacity	and	should	be	re-
writeable.

Ans.	 A Pen Drive using Flash Memory is more preferable, as it is not only fast for reading and writing, 
but also portable for the Phantom Programmer to carry here and there.
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I.	 Tick	(√)	the	correct	option.

1. Name the type of software that is designed to operate the computer hardware and to provide a 
platform for running application software.

 a.  Application Software b.  Web-Based Software

 c.  System Software  d.  None of these

Ans.	 c. System Software

2. Which among the following is not an Operating System?

 a.  Unix  b.  Android

 c.  Microsoft Word  d.  Microsoft Windows

Ans.	 c.  Microsoft Word

3. Which among the following is used for controlling the peripheral devices?

 a.  Assembler  b.  Operating System

 c.  Library Programs d.  Web Based programs

Ans.	 c.  Library Programs

4. Which among the following is not an Antivirus software?

 a.  WinZip  b.  McAfee

 c.  Quick Heal  d.  Kaspersky

Ans.	 a. WinZip

5. A Utility software that speeds up the system by arranging files stored on the hard disk at discrete 
location to occupy contiguous storage locations:

 a.  Antivirus  b.  Compression Utility

 c.  Text Editor  d.  De-Fragmentation Utility.

Ans.	 d. De-Fragmentation Utility

6. Which among the following is a type of translator that converts a program line-by-line to machine 
language while executing it?

 a.  Assemblers  b.  Compilers

 c.  Interpreters  d.  None of these

Ans.	 c.  Interpreters

Types of Software
Chapter 2
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7. Which of the following is not an example of a Word Processor?

 a.  Microsoft Word  b.  Adobe Pagemaker

 c.  OpenOffice Writer  d.  OpenOffice Calc

Ans.	 d. OpenOffice Calc

8. Name the software that helps in organizing and analysis of information in tabular form.

 a.  Word Processor  b.  Presentation Tools

 c.  Spreadsheet Tools  d.  Database Management System

Ans.	 c. Spreadsheet Tools

9. Which of the following is an example of DBMS?

 a.  OpenOffice Writer  b.  OpenOffice Impress

 c.  OpenOffice Calc  d.  OpenOffice Base

Ans.	 d. OpenOffice Base

10. Which among the following is not a Mobile Application?

 a.  Native apps  b.  Web apps

 c.  Hybrid apps  d.  System apps

Ans.	 d. System apps

II.	 Fill	in	the	blanks	with	the	given	words.

1. Software is a program or a group of instructions given to the computer to perform a particular 
task.

2. Antivirus is a software that is used to remove viruses and other malware programs from an 
infected computer.

3. The Quarantine option in an Antivirus Software is used to disable a virus, which is too difficult 
to remove.

4. The Utility programs are used to enhance the functionality of a computer system.

5. It is always advisable to take Backup in case there is any damage or accidental damage to the 
computer system to protect its content.

6. Library Programs are a way of sharing common programs that do not need to be re-written for 
each piece of software.

7. Language	Processors are translators that converts programs written in High-Level Language to 
Machine Language.

8. Presentation	Tool is a software that facilitates the creation of presentations on any particular 
topic.

9. Encryption is the technique of converting a content into un-understable form.

10. A mobile	app is a software application developed specifically for use on small hand-held devices.
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III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).
1. Computerised Reservation System is a software that allows you to conduct transactions related 

to railway or air travel. T
2. An Attendance Module is a part of Human Resource Management System. T
3. Finger Print Reader is a biometric device mostly used in an Attendance System. T
4. Mobile web apps are the web applications to render/deliver pages on web browsers running on 

mobile devices. T
5. General Application software can only be used specifically for an organization. T
6. An assembler is used to convert a high level language program to low-level language. T
7. Tally is a Mobile application. T
8. Android is an operating system for a Personal Computer (PC). T
9. Proximity Reader is a device that senses an employee within its proximity and marks the person 

present or absent as attendance. T
10. OpenOffice Writer is a customised software. T

IV.	 Short	Answer	Type	Qusetions	(SA-I)

1. What	is	a	software?

Ans.	 Software refers to a program or group of instructions that are given to the computer, which is 
stored in the main memory to perform a specific job.

2. What	is	a	database	management	system?

Ans.	 A Database Management System (DBMS) is a software package that enables you to store, modify 
and extract information from a database.

3. State	any	one	use	of	an	accounting	management	software.

Ans.	 Accounting Management Software is used to generate Balance Sheet for a company or an 
individual.

4. What	is	human	resource	management?

Ans.	 A Human Resources Management System (HRMS) is just the software application that caters to 
the management of the human resources of an organization. It combines many human resources 
functions including benefits administration, payroll, recruiting and training, and performance 
analysis and review into one package.

5. What	is	the	function	of	a	proximity	reader	in	an	attendance	system?

Ans.	 These devices are very advanced compared to the above mentioned Attendance system devices. 
It just senses an employee within its proximity and marks the person present or absent.

V.	 Short	Answer	Type	Qusetions	(SA-II)

1. What	is	system	software?	Name	the	different	types	of	system	software.

Ans.	 System software is collection of programs that is used to service or help other programs during 
execution.
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The different types of System Software are:

•   Operating System  •   Utility Programs

•   Library Programs  •   Programming Language Translators

2. State	two	functionalities	of	an	operating	system.

Ans.	 i.  It acts as an interface between the computer and the user.

 ii. It controls all hardware and software resources of the computer system.

3. What	is	an	anti-virus	software?	Also	explain	the	term	quarantine	with	respect	to	anti-virus	
software.

Ans.	 Virus Scanner or Antivirus is a utility software that is used to remove viruses and other malware 
programs from the computer.

 Quarantine: Certain virus may be too difficult to be removed completely, this virus are disabled 
and kept in a safe place so that it cannot infect other files.

4. What	are	mobile	applications?

Ans.	 A mobile application, most commonly referred to as an app, is a type of application software 
designed to run on a mobile device, such as a smartphone or tablet computer.

5. What	is	the	use	of	compression	utility	software?

Ans.	 Compression utility software is used to compress a file to a smaller size, which may then be used 
for storage or transfer from one computer to another.

6. State	at	least	two	advantages	of	using	a	backup	utility	software.

Ans.	 1. Taking regular backups makes data reliable.

 2. Taking regular backups can make recovery easier during catastrophic disaster.

7. How	does	the	process	of	defragmentation	speed	up	the	computer	system?

Ans.		 Disk de-fragmentation utility software speeds up the system by rearranging files stored on the 
hard disk to occupy contiguous storage locations using a technique called defragmentation. This 
leads to minimizing the head travel, which reduces the time it takes to read files from and write 
files to the disk.

8. What	are	library	programs?

Ans.	 Library Programs are a way of sharing common programs so that they do not need to be re-
written for each piece of software. For example, the use of mouse is almost same in different 
application software.

9. What	is	the	significance	of	using	language	translator?

Ans.	 A Programming Language Translator is responsible for converting programs written in a computer 
language to machine language. There are three types of translator namely Assemblers, Compilers 
and Interpreters.
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10. State	one	difference	between

 a. Compiler and interpreter. 

 b. Standard software and customised software

Ans.	 a.  Interpreter converts each line of a program to machine language whereas Compiler converts 
an entire program to machine language as a whole.

 b.  Standard or Generic Software is a general purpose software that is mass produced with 
the intention that it will be used by a wide variety of different users in a range of different 
situations.  Customised software on the other hand as the name suggest, is more specific 
towards a particular organization or an individual. Such software’s meets the requirements of 
that organization or individual to whomever it may be concerned. It is created for a specific 
purpose which will be used in a known environment.

11.  What	is	a	presentation	tool?	Give	two	examples	of	a	presentation	software.

Ans.	 Presentation Tool is a software that facilitates the creation of presentations on any particular 
topic. A presentation is a combination of slides, handouts, notes and outlines all kept in a single 
file. It is possible to add text, graphics, photos, clip art, sound and video to your slides.

 Examples OpenOffice Impress and Microsoft PowerPoint.

12. Which	software	is	used	to	analyse	statistical	data?	Give	two	examples	of	such	software.

Ans.	 Spreadsheet is used to analyse statistical data.  Examples OpenOffice Calc and Microsoft Excel.

13. State	two	features	of	accounting	management	software.

Ans.	 Two features of Accounting Management Software are:

 •  Financial Accounting (Multi-Currency)

 •  Inventory Management (Multi-location)

14. What	is	a	reservation	system?

Ans.	 Reservation System or Computerised Reservation System is a software that is used to store and 
retrieve information and conduct transactions related to railway travel, air travel, hotels, car 
rental, or activities. Reservation System was originally designed and operated by airlines, but 
currently is extended extensively by Indian railways and also by travel agencies.

15. What	is	the	function	of	a	payroll	module	in	a	human	resource	management	software?

Ans.	 The Payroll module is responsible for automating the pay process by gathering data on employee 
time and attendance, calculating increments, calculating various deductions and taxes, and 
generating periodic pay cheques and employee tax reports.

16. Name	two	devices	that	are	used	as	an	automated	attendance	system.

Ans.	 Two devices that are used as an automated Attendance System:

 •  Finger Print Reader

 •  Proximity Reader
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17. What	is	the	function	of	a	inventory	control	system?

Ans.	 An inventory control system is an application that encompasses all aspects of managing a 
company’s inventories i.e. purchasing, shipping, receiving, tracking, warehousing and storage, 
turnover and reordering.

18. State	one	difference	between	native	app	and	web	app.

Ans.	 Native apps are built for a specific operating system. A native app developed for iOS operating 
system won’t work on Android devices and vice-versa. If an app is developed for iOS, it will 
remain exclusive to that operating system.

 Web apps on the other hand are the web applications to render/deliver pages on web browsers 
running on mobile devices. Since these apps target browsers, they work on different mobile 
operating systems. Web apps are mobile-optimized web pages that look like an app.

VI.	 Long	Answer	Type	Questions(LA)

1.  What	is	the	significance	of	using	a	billing	system?

Ans.	 It provides many facilities to the people working through it. In the billing process one simply 
have to add the information into the data base and all the calculations are done by the billing 
services provider itself. It handles all the data merging, copying from the sources and application 
of different formulas on it to get the required results for the company.  It helps to maintain the 
system of the costumers, their records and helps to ensure the working of the entire system of 
the company.

2. Describe	the	use	of	accounting	management	software.

Ans.		 Accounting software is a class of computer programs that enable you to manage your business’s 
financial transactions. Such programs can vary widely in scope, with some programs designed for 
little more than simple bookkeeping and some designed to manage the entire financial comings 
and goings of large businesses. Using accounting software helps companies to use the resources 
in their accounting departments efficiently, and can reduce costly bookkeeping mistakes.

3.  What	are	presentation	tools	used	for?

Ans.		 Presentation Tool is a software that facilitates the creation of presentations on any particular 
topic. A presentation is a combination of slides, handouts, notes and outlines all kept in a single 
file. It is possible to add text, graphics, photos, clip art, sound and video to your slides.

4. Explain	the	working	of	a:

 i. Interpreter  ii. Compiler
Ans.

Interpreter Compiler

Translates program one statement at a time. Scans the entire program and translates it as 
a whole into machine code.
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It takes less amount of time to analyze the 
source code but the overall execution time 
is slower.

It takes large amount of time to analyze the 
source code but the overall execution time is 
comparatively faster.

No intermediate object code is generated, 
hence are memory efficient.

Generates intermediate object code which 
further requires linking, hence requires more 
memory.

Continues translating the program until 
the first error is met, in which case it stops. 
Hence debugging is easy.

It generates the error message only after 
scanning the whole program. Hence 
debugging is comparatively hard.

Programming language like Python, Ruby use 
interpreters.

Programming language like C, C++ use 
compilers.

5. What	is	the	function	of	encrytion/decryption	tool?

Ans.	 Encryption is the conversion of electronic data into another form, called ciphertext, which cannot 
be easily understood by anyone except authorized parties.  The primary purpose of encryption 
is to protect the confidentiality of digital data stored on computer systems or transmitted via the 
Internet or other computer networks.  

 Decryption is the process of transforming data that has been rendered unreadable through 
encryption back to its unencrypted form. In decryption, the system extracts and converts the 
garbled data and transforms it to texts and images that are easily understandable not only by 
the reader but also by the system.

6. What	are	hybrid	apps?

Ans.	 Hybrid apps are a mixture of both native and mobile web apps and therefore target multiple 
platforms. This type of application has cross-platform compatibility but can still access phone’s 
hardware. Softwares used to develop these apps are generally HTML, CSS, Javascript, JQuery, 
Mobile Javascript frameworks, Cordova/PhoneGap, etc.

Application	based	questions

1.  Below	 are	mentioned	 some	 of	 the	most	 common	 general	 purpose	 software,	 give	 a	 short	
description	of	them	also	give	two	examples	of	such	a	software:

 

General	Purpose	Software Define Examples

Word processor

Spreadsheet

presentation Tool

DBMS

Accounting System
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Ans.

General	Purpose	
Software Description Examples

Word Processor

Word processing is a term used in computer 
education for typing , editing, saving it for future 
reference and printing any kind of text-letters, 
memos, articles, reports and even books.

Microsoft Word and 
OpenOffice Writer

Spreadsheet

A spreadsheet is a computer application that 
helps in organizing and analysis of information 
in tabular form. It is primarily used to work with 
statistical data and can also help in organizing 
information, to calculate and analyze using 
mathematical formulas.

Microsoft Excel and 
OpenOffice Calc

Presentation Tool

Presentation Tool is a software that facilitates 
the creation of presentations on any particular 
topic.  A presentation is a combination of slides, 
handouts, notes and outlines all kept in a single 
file.

Microsoft Powerpoint 
and OpenOffice 
Impress

DBMS
A Database Management System (DBMS) is a 
software package that enables you to store, 
modify and extract information from a database.

MySQL and Oracle

Accounting System

Accounting System is a practical application of 
management techniques to analyse, control 
and report on the financial health of the 
organization. Thus requiring analysis, planning, 
implementation and control of programs 
designed to provide financial data reporting for 
managerial decision making.

Busy and Tally

2.  Kapil	finance	limited	a	microfinance	firm	is	planning	to	computerise	its	office	to	give	better	
service	to	its	customers.	Here	are	some	the	task	the	firm	needs	to	do:

	 a.	Write	profile	of	the	firm.
	 b.	Stores	the	name	and	addresses	of	the	customers.
 c. Send	letters	to	customers.
	 d.	Keeps	the	account	of	the	money	being	approved	for	a	customer.
	 e.	Give	salaries	to	its	employees.
	 f.	Present	different	products	to	the	employees.
	 Suggest	suitable	general	purpose	software	that	may	be	used	to	perform	each	of	the	above	

task.

Ans.	 a. Word Processor-OpenOffice Writer

 b. Data Base Management System- MySQL
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 c. Word Processor-OpenOffice Writer

 d.  Spreadsheet Tool-OpenOffice Calc

 e. Spreadsheet Tool-OpenOffice Calc

 f. Presentation Tool-OpenOffice Impress

3. St.	Antony’s	School	Vishakapatnam	is	planning	to	provide	computerised	Progress	Report	to	its	
students.	As	the	school	is	affiliated	to	CBSE,	proper	norms	of	projects	and	assigments	needs	to	
be	kept.	Apart	from	the	aforesaid	norms	it	also	accesses	a	student	on	other	co-curricular	and	
extra-curricular	activities.	The	problem	is,	the	school	is	finding	it	difficult	to	get	an	adequate	
software	according	to	its	requirement.	Suggest	a	suitable	software	between	General-	Software	
and	Customised	Software	along	with	reasons	for	the	school	to	use.

Ans.	 The school should opt for a Customised software as there is no generalised software according 
to the requirement of the school.  Thus a software is required which should be tailor made 
according to the requirement of the school.
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I	 Tick	(√)	the	correct	option.

1. Which among the following is not an example of an Operating System?

 a. Windows 7  b. Linux

 c. Unix  d. Microsoft Word

Ans.	 d. Microsoft Word

2. Name the type of Operating System that allows supports and allocates programs on more than 
one CPU.

 a. Multiuser Operating System b. Multiprocessing Operating System

 c. Distributed Operating System d. None of the above

Ans.	 b. Multiprocessing Operating System

3. Which among the following has the fastest response time?

 a. Multiuser Operating System b. Multiprocessing Operating System

 c. Distributed Operating System d. Real Time Operating System

Ans.	 d. Real Time Operating System

4. Which among the following forms the core of the Operating System?

 a. User Interface  b. File Management

 c. Memory Management d. Kernel

Ans.	 d. Kernel

5. Which of the following does not come under the memory management of the Operating System?

 a.  It keeps track of the main memory and checks which part is in use and by which process. It 
also keeps track of the part that is not in use.

 b.  It checks whether the RAM is physically broken or not and gives a relevant message during 
the booting process.

 c. It makes a decision on which process will get memory when and by how much.  

 d. It allocates the memory according to the requirement of the process.

Ans.	 b. It checks whether the RAM is physically broken or not and gives a relevant message 
during the booting process.

6. Which among the following is not a type of system call?

 a. Process Control  b. File Management

Operating System
Chapter 3
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 c. BIOS  d. Device Management

Ans.	c.		BIOS

7. Which among the following is not a type of kernel?

 a. Macrokernel  b. Microkernel

 c. Nano Kernel  d. Hybrid Kernel

Ans.	 a. Macrokernel

8. Which among the file system is no longer supported by the developer?

 a. FAT 32  b. NTFS

 c. HFS  d. None of these

Ans.	 HFS

II.	 Fill	in	the	blanks	with	the	given	words.

1. An Operating	System	is a software that provides a platform for other applications to be executed.

2. The Distributed operating system allows software and data to be distributed around the system.

3. Booting is the process of loading the Operating System into the memory during start up.

4. Hybrid kernel runs a few services in the kernel space to reduce the performance overhead of 
traditional microkernels.

5. Hierarchical File System  was made by Apple.

6. Nano Kernel simplify the memory requirement by entrusting services, including the basic ones 
like interrupt controllers or timers to device drivers.

7. Process	Scheduling is the process through which the Operating System decides which process 
gets the processor when and for how much ime.

8. The Process	 control system call is used to end, abort, create, terminate, allocate and free 
memory 

9. The Kernel layer of the Operating System is responsible for multi-tasking, process control, 
exception handling and interrupt processing.

10. The User	Interface is a software layer which allows the user to interact directly with the operating 
system.

11. Multithreading is an Operating System that allows different parts of a single program to run 
concurrently.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. The HFS was developed and maintained by Apple. T
2. Real Time and Multi Threading Operating system behaves same like each other. F
3. Booting is the process of storing the Operating System into the Hard Disk.  F
4. Tracking of files and folders is the File Management functionality.  T
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5. Operating System is not responsible for de-allocating the memory when a  
process no longer requires it.  F

6. An Application Software can execute even without an Operating system.  F
7. User Interface layer is the core of an operating system.  F
8. FAT 32 file system is better than NTFS file system.  F
9. An Application Software allocates the CPU to a process.  F
10. The Device Drivers are special software designed to enable interaction with hardware devices. T

IV.	Short	Answer	Type	Questions	(SA-I)

1. What	is	an	operating	system?

Ans.	 An operating system (OS) is software that manages computer hardware and software resources 
and provides common services for computer programs.

2. What	are	system	calls?

Ans.	 In computing, a system call is the programmatic way in which a computer program requests a 
service from the kernel of the operating system it is executed on.

3. What	is	a	real	time	operating	system?

Ans.	 A real-time operating system (RTOS) is an operating system (OS) intended to serve real-time 
applications that process data as it comes in, typically without buffer delays.

4. State	any	one	function	of	the	memory	management	of	the	operating	system.

Ans.	 The memory management function of an operating system keeps track of the main memory and 
checks which part is in use and by which process. It also keeps track of the part that is not in use.

5. What	is	an	user	interface?

Ans.	 User Interface refers to the visual part of an operating system through which a user interacts 
with a computer or a software.

V.		 Short	Answer	Type	Questions	(SA-II)

1. Why	is	an	operating	system	needed	for	a	computer	system?		

Ans.	 In earlier day’s user had to design the application according to the internal structure of the 
hardware. Operating System was needed to enable the user to design the application without 
concerning the details of the computer’s internal structure. In general the boundary between 
the hardware & software is transparent to the user.

2. What	is	a	interactive	operating	system?

Ans.	 Interactive (GUI based) Operating System: GUI or Graphical User Interface based Operating 
System allows the use of icons, windows and menus as tools to interact with the computer.

3. How	is	a	real	time	operating	system	different	from	distributed	operating	system?

Ans.	 A distributed OS provides  the essential services and functionality required of an OS, adding 
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attributes and particular configurations to allow it to support additional requirements such as 
increased scale and availability.  To a user, a distributed OS works in a manner similar to a single-
node, monolithic operating system. That is, although it consists of multiple nodes, it appears to 
users and applications as a single-node.

 A real time operating system is intended to serve real-time application process data as it comes 
in, typically without buffering delays. Processing time requirements (including any OS delay) are 
measured in tenths of seconds or shorter.

4. What	do	you	understand	by	the	term	“Device	Management”?

Ans.		 It is used to keep track of all I/O (Input/Output) devices like monitor, keyboard, mouse, scanner, 
etc., and the program responsible for this task is known as the I/O controller.

5. State	any	two	functions	of	memory	management	by	the	operating	system.

Ans.		The following are the functions associated with the memory management:

 •   The kernel keeps track of the main memory and checks which part is in use and by which 
process.  It also keeps track of the part that is not in use.

 •   The kernel makes a decision on which process will get memory when and by how much?  Thus 
each process must have enough memory in which to execute, and should not overlap the 
memory space of another process nor be run into by another process.

6. Name	the	different	type	of	services	provided	by	system	calls.

Ans.	 The following are some of the services provided by the system calls:

 • Process creation and management

 • Main memory management

 • File Access, Directory and File system management

 • Device handling(I/O)

 • Protection

 • Networking

VI.		 Long	Answer	Type	Questions	(LA)

1. State	the	activities	of	an	OS	related	to	“File	Management”.

Ans.	 The activities related to File Management includes:

	 a.	File Attributes

 File attributes are the properties associated with a file that specifies the different information 
related to the file or data of the file. It specifies the characteristics of a file, such as a type and 
location that completely describe a file.

	 b.	File Operations

 File operations are the various tasks that are performed on files. A user can perform these 
operations by using the commands provided by the operating system. 

 c. File Access Permissions
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 File access permission help specify the manner in which a user can access a file. These are the 
access rights that allow us to read, write or execute a file. 

	 d.	File System

 File systems are used by an operating system to store and organize the various files and their 
information on a hard disk. 

2. What	are	the	different	type	of	system	calls	in	an	operating	system?

Ans.	 Types of System Calls: There are 5 different categories of system calls:

 • Process control which is used to end, abort, create, terminate, allocate and free memory.   

 • File management which is used to create, open, close, delete, read file etc.

 • Device management

 • Information maintenance

 • Communication

3. State	the	activities	of	a	OS	related	to	“Processor	Management”.

Ans.	 • The operating system keeps track of the processor and the status of process.

 • The operating system allocates the processor (CPU) to a process.

 •  The operating system is also responsible for de-allocating the processor when processor is no 
longer required.

4. State	the	features	of	a	interactive	(GUI	based)	operating	system.

Ans.	 Interactive (GUI based) Operating System:  GUI or Graphical User Interface based Operating 
System allows the use of icons, windows and menus as tools to interact with the computer. For 
example such tools may be used for opening, deleting, and moving files. Usually GUI operating 
systems are navigated through the use of a mouse, the keyboard may also be utilized by using 
keyboard shortcuts or arrow keys to speed up operations.  Because of their ease of use, GUI 
operating systems have become the dominant operating system used by today’s end-users.  
Windows is an example of GUI based Operating System.  

5. How	is	FAT	32	file	system	different	from	NTFS?

Ans.	 FAT32 and NTFS are file systems created for keeping track of files in the hard disk. A file system 
is a set of logical constructs that dictate how the space on a disk volume is to be utilized. NTFS 
is more robust and effective simply because of its advanced features and functionalities. FAT, 
in general, comprises of overly simplistic data structures, hence making operations more 
time consuming. The functionalities of NTFS are far more over-powering since it makes use of 
advanced data structures to improve reliability, disk space utilization and overall performance.

Application	based	Questions

1. Sadhana	 want	 her	 personal	 office	 PC	 to	 be	 secured	 and	 protected.	 Suggest	 some	 builtin	
features	of	the	operating	system	that	gives	her	the	protection	and	security	required.

Ans.		 Some of the built-in features of an operating system that would give Mrs Sadhana protection 
and security are:
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 • It allows user accounts for each individual accounts for each user,

 •  It allows user authorisation can be attained using password protection.

 •  It allows the user to define and thus allows accessibility of different kind of information for 
different people.

 •  It allows data encryption thus allowing protection of data by making it un-understandable for 
those for which it is not meant for.

 • It allows data backup for storing data on a peripheral device other than the hard disk. 

 •  In a networked environment, only trusted computers should be able to share data. Some of 
the common security threats occur due to hacking, viruses, etc.

2.  Mr	Rohan	just	started	learning	about	computer.	He	is	planning	to	buy	a	computer	system,	but	
he	got	stuck	with	the	requirement	of	the	operating	system’s	user	interface.	Suggest	him	an	
user	interface	along	with	reasons.

Ans.		 For Mr. Rohan an Operating System that provides Graphical User Interface is more preferable as 
it is easy to master without much of an effort unlike a Character User Interface which requires 
some effort, because Mr. Rohan needs to know the different commands through which he can 
make the computer do some task.

3.  One	of	the	primary	features	of	an	operating	system	is	file	management.	State	at	least	three	
functionalities	of	the	file	management.

Ans.		 The File Management feature of an Operating System provides the following functionalities:

 •  It handles the organisation and tracking of files and directories (folders) saved or retrieved 
from the secondary storage devices.

 •  It allows the user to perform such tasks as creating files and directories, renaming files, copying 
and moving files, and deleting files.

 •  It keeps track of information, location, uses, status etc of the file system.

 •  It decides which process gets the secondary memory resources, allocates the resources and 
de-allocate the resources when the process is complete.

4.  Samir	a	student	of	engineering	is	designing	an	operating	system	on	a	pre-defined	kernel.		What	
should	be	used	to	interact	or	call	the	kernel	services.		Also	state	some	of	services	provided	by	
the	call.

Ans.		 To interact or call the kernel services System Call is used.  The following are some of the services 
provided by the system calls:

 • Process creation and management

 • Main memory management

 • File Access, Directory and File system management

 • Device handling(I/O)

 • Protection

 • Networking
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5. “Memory	management	 capability	of	 a	 kernel	 refers	 to	management	of	 primary	memory”.	
State	three	functions	of	memory	management	of	an	operating	system.

Ans.	 The following are the functions associated with the memory management:

 •   The kernel keeps track of the main memory and checks which part is in use and by which 
process.  It also keeps track of the part that is not in use.

 •   The kernel makes a decision on which process will get memory when and by how much?  Thus 
each process must have enough memory in which to execute, and should not overlap the 
memory space of another process nor be run into by another process.

 •  The kernel allocates the memory according to the requirement of the process.

6. Rekha	had	got	a	new	printer	her	birthday.	She	looked	at	the	manual	and	connected	the	cables	
accordingly.	She	even	inserted	the	printer	cartridge	carefully.	Now	when	she	tried	printing	a	
document	in	Word	2016,	the	printer	would	not	print.	State	with	reason	why	is	the	printer	not	
printing.	Also	state	the	measures	she	should	take	for	making	the	printer	work	correctly.

Ans.		 This is because the Device Driver for the printer is not installed. The printer packaging must 
be coming with a CD/DVD for the device driver installation or can be downloaded from the 
internet, only then the printer would function.
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I.		 Tick	(√)	the	correct	option.

1. Which of the following transmission medium is the costliest?

 a. UTP   b. STP
 c. Coaxial Cable   d. Optical Fibre
Ans.	 d. Optical Fibre

2. Which among the following is used for transmission in short range (mobile phone) devices?

 a. Infrared   b. Bluetooth
 c. Coaxial Cable   d. Optical Fibre
Ans.	 b. Bluetooth

3.  Which transmission would you use which can be setup at no time if the cost of digging the land 
for placing the cables is high?

 a. Microwaves   b. Satellite Link
 c. Infrared Waves   d. Bluetooth
Ans.		 a. Microwaves

4.  Which among the following protocol is used for transferring a web page from a web server to a 
web browser?

 a. HTTP   b. SMTP

 c. FTP   d. TCP
Ans.		 a. HTTP

5.  Which of the following is not used for wired transmission?
 a. Coaxial Cables   b. Optical Fibre

 c. Twisted Pair Cable   d. Microwaves
Ans.		 d. Microwaves

6.  Which among the following protocols used for Internet Telephony?
 a. HTTP   b. SMTP
 c. FTP   d. VoIP
Ans.		 d. VoIP

7.  What is the set of rules called that is used for transmission of data over a network?
 a. LAN  b. WAN
 c. Protocol   d. Transmission Media
Ans.	 c. Protocol

Computer Networking
Chapter 4
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8. What is the practice of using a network of remote servers hosted on the Internet to store, 
manage, and process data, rather than a local server or a personal computer?

 a. Internet Computing  b. Cloud Computing

 c. Protocol   d. Transmission Media

Ans.	 b. Cloud Computing

9.  Which among the following is not a type of cloud?

 a. Public   b. Private

 c. Protected   d. Hybrid

Ans.	 b. Private

10.  In which type of cloud, the infrastructure is shared between several organizations of a specific 
community or group with common goals and security specifications?

 a. Public   b. Private

 c. Community   d. Hybrid

Ans.	 c. Community

II.		 Fill	in	the	blanks	with	the	given	words.

1. A Private cloud is meant only for one organisation.

2. A hybrid cloud is a mix of private and public cloud.

3. SMTP is the standard protocol for sending emails across the Internet.  

4.  HTTP is a protocol used for transferring a web page from a web server to a web browser.  

5.  FTP  protocol is used to transfer files between two computers on the Internet.

6.  The transmission from the earth to the satellite is known as Uplink.

7.  Infrared waves have its frequency just less than red light.

8.  In microwave transmission high Towers are used.

9.  Optical fibres uses Light as its source of data transmission.

10.  A hotspot is a venue that offers Wi-Fi access.

III.		 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1.  Networking allows sharing of printers. T
2.  WAN spans over an area near an individual. F
3.  LAN spans over small area, usually within a room or a building. T
4.  PAN spreads overs a very small area usually at the vicinity of a device. T
5.  Microwaves are used in LAN. F
6.  Bluetooth technology is used for communication is most hand-held devices. T
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7.  Optical fibers though expensive, is the fastest and most reliable transmission medium. T
8.  Satellite link is used for radio waves communication. F
9.  Data transmission rate in coaxial cable is slower than the twisted pair cable. F
10.  Radio Waves are used in walky-talkies. T

IV.	 Short	Answer	Type	Questions	(SA-I)

1. What	is	a	Computer	Network?

Ans.	 A computer network is a group of computer systems and other computing hardware devices 
that are linked together through communication channels to facilitate communication and 
resource-sharing among a wide range of users.

2. List	two	advantages	of	a	network.

Ans.	The following are some of the most important uses and benefits of a computer network.

	 •		File	sharing: Networking of computers helps the network users to share data files.   

	 •			Hardware	sharing: Users can share devices such as printers, scanners, CD-ROM drives, hard 
drives, etc. 

3. Name	the	type	of	network	that	spans	over	an	area	near	an	individual,	typically	within	a	range	
of	10	meters.

Ans.	 PAN(Personal Area Network)

4. Name	two	guided	media	used	in	a	network.

Ans.		 Twisted Pair and Co-axial

5. What	is	a	protocol?

Ans.	 In computing, a protocol or communication protocol is a set of rules in which computers 
communicate with each other. The protocol says what part of the conversation comes at which 
time. It also says how to end the communication.

V.		 Short	Answer	Type	Questions	(SA-II)

1. State	two	advantages	of	infrared	waves.		

Ans.	 Advantages

 •  Compared to other transmission media infrared transmission consumes less power.

 •  Cost of setting up, i.e., the circuit is very economical.

2. State	two	disadvantages	of	microwaves.

Ans.	 Disadvantages

 •	Line-of-sight will be disrupted if any obstacle, such as new buildings, are  in the way.

 •	Difficult weather conditions like rain, thunder, storm, lightening affects microwave transmission.



Computer Applications – IX (CBSE Course) Answers 28

3. What	is	a	wi-fi	hotspot?

Ans.		 A hotspot is a physical location where people may obtain Internet access, typically using Wi-Fi 
technology, via a wireless local area network (WLAN) using a router connected to an internet 
service provider.

4. What	are	protocols	used	to	determine?

Ans.		 The protocols are used to determine the following:

	 •		type of error checking to be used, data compression method (if any), 

	 •			how the sending device will indicate that it has finished a message and how the receiving 
device will indicate that it has received the message. 

5. State	the	difference	between	TCP	and	IP.

Ans.		 TCP/IP is a two-layer program where the higher layer, TCP, manages the assembling of a message 
or file into smaller packets that are transmitted over the Internet and received by a TCP layer 
that reassembles the packets into the original message. The lower layer, IP, on the other hand 
handles the address part of each packet so that it gets to the right destination.

VI.		 Long	Answer	Type	Questions	(LA)

1.  What	is	an	optical	fibre?	What	are	its	different	components?

Ans.		 Optical Fibers consist of thin strands of long glass whose thickness of that of a human hair.  
These wires are arranged in bundles which are technically called optical fiber cables and used 
to transmit data through light signals over long distances using the principle of Total Internal 
Reflection.  It transmits an optical fiber has following parts:

	 •		Core - It is the thin glass rod at the center through which the light travels

	 •			Cladding - It is the outer optical material surrounding the core that reflects the light back into 
the core

	 •		Buffer coating - It is the plastic coating that protects the cable from damage and moisture

2.  Write	a	short	note	on	Radio	Waves.

Ans.		 Radio waves have a frequency ranging from 3 KHz to 3GHz. It is used for communication over 
short distances like from a few meters (as in walkie-talkies) upto covering an entire city. It is 
easier to generate these waves and can travel long distances and is able to penetrate buildings 
easily.  This makes it widely used in both indoor and outdoor communication.

3.  Why	are	satellite	links	used	even	though	it	is	expensive?

Ans.		 Even though these systems are expensive, the area it covers compensate for the expenses. The 
communication satellites are generally owned by governments or by government approved 
organizations of various countries.

4.  What	is	WiMAX?

Ans.		 WiMAX (Worldwide Interoperability for Microwave Access) is a wireless communications 
standard designed to provide 30 to 40 megabits-per-second data rates.  WiMax requires a tower 
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called WiMax Base Station, similar to a cell phone tower, which is connected to the Internet 
using a standard wired high-speed connection.  But as opposed to a traditional Internet Service 
Provider (ISP), which divides that bandwidth among customers via wire, it uses a microwave link 
to establish a connection.  In other words, WiMax does not depend on cables to connect each 
endpoint, the Internet connectivity to an end-user is provided through microwave link between 
the tower and the user-endpoint, known as Wi-Max subscriber unit.

5.  State	two	advantages	and	disadvantages	of	Bluetooth.

Ans.	 Advantages

 •   Connection establishment is very quick and easy, you just need to pair the Bluetooth PAN 
connection between two devices. 

 •  It has low power consumption. 

 •  It can pass through walls unlike Infrared.

	 Disadvantages

 •  Bluetooth communication is insecure.

 •  It is used only for short range communication.

 •  Power consumption is very high compared to a condition when Bluetooth is powered off.

Application	based	Questions

1.  Tarini	Fancy	Inc.	is	planning	to	connect	all	computers	in	their	office	building	spread	over		an	
area	of	50	metres.

 a.   Suggest the most economical cable type having high data transfer speed which can be used 
to connect these computers.

Ans.	 Twisted wire cable

 b.  Which type of network (out of WAN, LAN and MAN)?

Ans.	 LAN

 c.  Which device will be used to connect all the computers?

Ans.	 Hub/Switch

2.  Shobhit	wants	to	create	a	network	for	his	computers	in	his	office	for	sharing	of	hardware	and	
software	resources.

 a.  What type of network will be formed (LAN, MAN and WAN)?

Ans.	 LAN

 b.  To keep things economical suggest a type of transmission media over a network.

Ans.	 Twisted Pair Cable

 c.  What device should be present in each computers for the cable to connect?

Ans.	 Network Interface Card (NIC)
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 d.   He also wants an internet connection for the network, name the device which is primarily 
used for the internet connectivity.

Ans.	 Modem

3.  Swapan	 wants	 to	 send	 a	 video	 to	 Sinha	 sitting	 beside	 him	 on	 her	 mobile	 phone.	 What	
networking	technology	is	needed	to	share	a	video	through	the	mobile	phones?		Describe	it.

Ans.		 Bluetooth Technology

 It is an unguided media. It is one of the most popular technologies used in hand-held (mobiles 
and tablets) devices for transmission of data. Its frequency ranges from 2.402 GHz to 2.480 GHz 
and is therefore used for short range communication (approx. 10m). Its data transfer rate is too 
slow compared to other waves.

4.  Carefully	go	through	the	following	descriptions	and	identify	what	is	being	talked	about?

 a.  It consist of two insulated wires twisted around each other that provides protection against 
noise and cross talk.

Ans.	 Twisted Pair Cable

 b.  Disturbance caused due to interference of one signal’s electric or magnetic field into other 
signals.

Ans.	 Crosstalk

 c. It is a device used to convert digital signal to analog vice-versa.

Ans.	 Modem

 d.  It is a software program that allows multiple users to communicate online with realtime 
audio, video and text chat in dynamic 3D environments.

Ans.	 Interspace

 e. It is a device which is used to amplify the signal which is being transmitted.

Ans.	 Repeater
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I.	 Tick	(√)	the	correct	option.

1. Which among the following are types of multimedia?

 a. Linear  b. Non-Linear

 c. Both a and b  d. None of these

Ans.	 c. Both a and b

2. Which among the following is not an element of multimedia?

 a. Audio  b. Video

 c.  Animation  d. Keyboard

Ans.	 d. Keyboard

3. Which among the following graphics format is used to  create digital images through a sequence 
of commands or mathematical statements that place lines and shapes in a given two-dimensional 
or three-dimensional space?

 a. Vector graphics  b. Raster graphics

 c. Linear graphics  d. Non-linear graphics

Ans.	 a. Vector graphics

4. What is the full form of JPEG of image format?

 a. Joint Photographic Experts Groups  b. Joint Photographic Experts Graphics 

 c. Joint Photographic Elemental Groups  d. Joint Picture Experts Groups 

Ans.	 a. Joint Photographic Experts Groups

5. Which among the following image formats uses animation?

 a. TIFF  b. BMP

 c. GIF  d. PNG

Ans.	 c.  GIF

6. What is the full form of MPEG used in audio formats?

 a. Moving Picture Experts Group b. Moving Pixel Experts Group

 c.  Moving Picture Experts Graphics d. Music Picture Experts Group

Ans.	 a. Moving Picture Experts Group

Multimedia, Chat Sites 
and Social Networks

Chapter 5
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7. Name the audio format that is a proprietary format, and is used for streaming audio that enables 
you to play digital audio files in real-time.

 a. WAV  b. RAM

 c. WMA  d. MIDI

Ans.	 b. RAM

8. Name the audio format which is a standard adopted by the electronic music industry for 
controlling devices, such as synthesizers and sound cards, that emit music. 

 a. WAV  b. RAM

 c. WMA  d. MIDI

Ans.	 d. MIDI

9. Name the video format developed by Apple.

 a. AVI  b. WMF

 c. MP3  d. MOV

Ans.	 d. MOV

10. Name the type of animation that describes the process in which a lead animator draws only the 
animation frames where major changes take place, called keyframes.

 a. Tweening  b. Frame by Frame

 c. Vector  d. Raster

Ans.	 a. Tweening

II.		 Fill	in	the	blanks	with	the	given	words.		 	 	

1. Virtual	Reality is a kind of technology to create a simulated environment.

2. Chat	Site is a part of an online service that provides a venue for people to exchange messages 
about a particular subject in real time. 

3. Social	 networking is the practice of expanding the number of one’s business and/or social 
contacts by making connections through individuals, often through social media sites such as 
Facebook, Twitter, LinkedIn and Google+.

4. Vector	 based	 animation is a graphic element is stored as a mathematical expression that 
describes its size, shape, position and other characteristics.

5. QuickTime is a video format developed by Apple. 

6. Ogg	is a free, open container audio format maintained by the Xiph.Org Foundation.

7. WMA is an audio format that can compress files at a higher rate compared to MP3.

8. The BMP image format developed by Microsoft do not have any compression or information 
loss.

9. Lossy compression will result in some loss of data as the compression algorithm eliminates 
redundant or unnecessary information. 

10. JPEG image format uses very less space though the compression is lossy.
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III.		 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1.  TIFF stands for Tagged Image File Format. T
2.  Vector graphics uses a dot matrix data structure. F
3.  Generative Graphics is extensively used in drawings and illustrations in the form of 2-D and 3-D 

pictures. T
4.  Non- Linear active content progresses often without any navigational control for the viewer 

such as a cinema presentation. F
5.  TIFF image format is best for web graphics. F
6.  BMP image format allows lossy compression. F
7.  GIF format is widely used graphics format for the web. T
8.  Real Audio files uses a lossy compression. F
9.  The MIDI is a standard format for digitizing audio of musical instruments. T
10.  Shockwave format video files has the .swf extension. T

IV.		 Short	Answer	Type	Questions	(SA-I)

1. What	is	multimedia?

Ans.		 Multimedia is the field concerned with the computer-controlled integration of text, graphics, 
drawings, still and moving images (Video), animation, audio, and any other media where every 
type of information can be represented, stored, transmitted and processed digitally.

2. List	two	types	of	multimedia.

Ans.	 Linear and Non-Linear

3. Name	any	hardware	and	software	requirement	for	text	element	in	multimedia.

Ans.	 The hardware and software requirements for text matter as follows:

 • Keyboard   • Optical Character Recognizers (OCR) 

 • Text Editors   • Text Style 

 • Text Searching   • Hypertext 

 • Text Importing & Exporting

4. What	is	generative	graphics?

Ans.	 Generative Graphics is extensively used in drawings and illustrations in the form of 2-D and 3-D 
pictures. It is created for mathematical representation of simple objects.

5. What	is	raster	graphics?

Ans.		 Raster graphics or bitmap image on the other hand is a dot matrix data structure, representing 
a generally rectangular grid of pixels, or points of color, viewable via a monitor, paper, or other 
display medium.
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V.		 Short	Answer	Type	Questions	(SA-II)

1. What	are	the	different	type	of	audio	formats	used	in	multimedia?		

Ans.		 They are:
 • Uncompressed audio formats
 • Lossless compression
 • Lossy compression

2. State	two	disadvantages	of	microwaves.

Ans.	 Disadvantages

 •  Line-of-sight will be disrupted if any obstacle, such as new buildings, are in the way

 •  Difficult weather conditions like rain, thunder, storm, lightening affects microwave transmission.

3. What	is	real	audio?	Name	the	file	extensions	of	real	audio.

Ans.		 Real Audio is a proprietary format, and is used for streaming audio that enables you to play 
digital audio files in real-time. 

 Files with this format has the .ra  .ram  or .rm extension.

4. What	does	MPEG	stand	for?		What	are	the	file	extensions	of	MPEG	file	format?

Ans.		 MPEG (Moving Pictures Expert Group) format is the most popular format on the Internet. It is 
cross-platform, and  supported by all the most popular web browsers. 

   Videos stored in the MPEG format have the extension .mpg or .mpeg.

5. What	is	tweened	path	animation?

Ans.		 Tweened path animation:    Tweening is a traditional animation term that describes the process 
in which a lead animator draws only the animation frames where major changes take place, 
called keyframes. Assistants draw the frames in between.   Adobe Flash may be used to create 
tweened path animation.

VI.		 Long	Answer	Type	Questions	(LA)

1.  What	is	virtual	reality?	What	are	its	kinds?

Ans.		 Virtual Reality:  It is a kind of technology to create a simulated environment. Unlike traditional 
user interfaces, Virtual Reality places the user inside an experience. Instead of viewing a screen 
in front of them, users are immersed and able to interact with 3D worlds.

 There are two kinds of Virtual Reality techniques:

 •  That allows a user to view a picture from many angles.

 •   A “world” is constructed of polygons in a 3D plane. The computer then renders in real time 
the world allowing you to walk through the world. 

2.  What	is	chatting?		State	two	advantages	and	disadvantages	of	chatting.

Ans.		 On the Internet, chatting is talking to other people who are using the Internet at the same time 
you are. Usually, this “talking” is the exchange of typed-in messages requiring one site as the 



35 Computer Applications – IX (CBSE Course) Answers

repository for the messages (or “chat site”) and a group of users who take part from anywhere 
on the Internet.

	 Advantages

 • Can communicate instantly

 • Can attach files

 • Fast

 • Cheap (almost free)

 Disadvantages

 • Need internet connection

 • Other person needs to be online

 • Lose non verbal communication (body language, tone of voice)

 •  Very hard to spot emotions of the people at the other end, which could be upset and you 
wouldn’t know it

 • Usually open to other people so not very secure.

3.  State	two	advantages	of	social	networking.

Ans.		 Advantages:

 Education	Field:  Social networks can be used to improve the education of adults and students 
since they already have certain influence on the learners.  Schools and teachers can take the 
advantage of social networking abilities to create discussion forums, class blogs and online 
teaching. Even students can further explore topics that they are interested in by using online 
social networking since they may have limited resources and time in school. 

 Business	Field:  Many companies use social networks such as Twitter and Facebook to connect 
with customers and prospective clients. This leads to a golden opportunity for job seekers to 
learn more about the organization and easily connect with people who work there. 

4.  What	is	cyber	bullying?

Ans.		 Cyber bullying is a type of cybercrime that involves harassment, where the abusive and insulting 
messages are repeatedly sent to the victim. Other kinds of cyber bullying such as flaming, 
denigration, impersonation, outing, trickery, and exclusion are also found in the world of social 
networks.

5.  What	is	digital	video?

Ans.		 Digital video is an electronic representation of moving visual images (video) in the form of 
encoded digital data. This is in contrast to analog video, which represents moving visual 
images with analog signals. Digital video comprises a series of digital images displayed in rapid 
succession.
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Application	based	Questions

1.  Suresh	wants	to	incorporate	compression	technique	for	his	multimedia	files.		Name	the	two	
compression	techniques	and	their	file	extensions.

Ans.		Uncompressed audio formats do not use any compression. Such files are of large sizes. A WAV 
audio file is an example of an uncompressed audio file.

 •   Lossless compression applies compression without losing information or degrading the quality 
of the digital audio file. The WMA audio file format uses lossless compression.

 •   Lossy compression will result in some loss of data as the compression algorithm eliminates 
redundant or unnecessary information.  It produces file size that is small, thus making it easier 
to transmit over the Internet. MP3 and Real Audio files uses a lossy compression.

2. Jiten	wants	 to	 develop	 a	multimedia	 application	 that	makes	 the	 user	 actively	 participate.		
What	type	of	multimedia	would	it	be?		Define	it.

Ans.		 Non-Linear:  Non-linear uses interactivity to control progress as with a video game or self-paced 
computer based training. Example: Hypermedia.

3. Chandrachur	 is	 developing	 a	music	 for	 the	 annual	 concert	 at	 school	 using	 his	 synthesizer.		
What	format	would	he	use?

Ans.		 MIDI

4.  Carefully	go	through	the	following	descriptions	and	identify	what	is	being	talked	about?

 a. It consist of a file format usually used in digital cameras.  Also give its full form.

Ans.	 JPEG - Joint Photographic Experts Groups 

 b.  Name the audio format that is popular for transfer of data over the internet and allows one 
to stream files even over internet connections with low bandwidths.

Ans.		 WMA and MP3

 c. Name the technique that is used to convert analog sound waves to a digital format.

Ans.		 Sampling

 d. It is an open container format maintained by the Xiph.Org Foundation.

Ans.		 Ogg

 e.  It is an audio format used for storing uncompressed sound in files, developed jointly by 
Microsoft and IBM.

Ans.	 WAV
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I.		 Tick	(√)	the	correct	option.

1. If someone says they are 16 you should 

 a. Believe them, they have no reason to lie 

 b. Not trust anyone you don’t personally know

 c. Give them your age 

 d. Meet up with them because they may be someone cool to hang out with 

Ans.	 b. Not trust anyone you don’t personally know

2. Who is the most common victim of online predators?

 a. Infants  b. Adults 

 c. 5-9 year olds   d. Teenagers 

Ans.	 d. Teenagers

3. Which among the following is not a malicious website?

 a. Address, Phone Number and/or Email address is present.

 b. The website address is not mis-spelled.

 c. The https:// at the beginning of the web site.

 d. The link shows a different address than what is mentioned.

Ans.	 c. The https:// at the beginning of the website

4. When visiting sites where you win something or they are giving something away

 a. Give your name, phone number, and address 

 b. Give parents information 

 c. Give no personal information (If it sounds to good to be true, it is)

 d. Give whatever information they request 

Ans.	 c. Give no personal information

5. You are online and you get an instant message from your internet service provider needing your 
password

 a. I give it to them because they are my ISP  b. I ask them why they need it 

 c. I never give my password to anyone  d. I log off without giving any information 

Ans.	c.		I	never	give	my	password	to	anyone

Cyber Safety
Chapter 6
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6. ____________ is a fraudulent practice of directing Internet users to a bogus website that mimics 
the appearance of a legitimate one.

 a. Virus  b. Malware

 c. Pharming  d. Chatting

Ans.	 c. Pharming

7. What is the private browsing mode in Internet Explorer/Edge called?

 a. InPrivate  b. Incognito

 c. PrivateIn  d. All of these

Ans.	 a. InPrivate

8. Which among the following is not a social networking site?

 a. Facebook  b. Gmail

 c. Twitter  d. Linkedln

Ans.	 b. Gmail

9. ______________ monitors user activity and transmit that information in the background to 
someone else.

 a. Malware  b. Spyware

 c. Adware  d. None of these

Ans.	 b. Spyware

10. Viruses are __________.

 a. Man made  b. Naturally occurring

 c. Machine made  d. All of these

Ans.	 a. Man made

II.		 Fill	in	the	blanks	with	the	given	words.

1. Unsolicited commercial email is called Spam.

2. Protect your computer and smartphone with strong, up-to-date security/anti-malware software.

3. A Virus is a piece of code which is capable of replicating itself and typically has a detrimental 
effect, such as corrupting the system or destroying data.

4. Biographical Information is submitted voluntarily in social networking sites.

5. The default privacy settings in social networking site is Public.

6. Tagging refers to  assigning a keyword or phrase that describes the theme of a group of articles, 
photos, videos, or other types of media files in social networking sites.

7. Confidentiality of information is defined as information to which the public does not have 
general access.
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8. Cyberstalking is a crime in which the attacker harasses a victim using electronic communication.

9. An authentication process, ensures that authorized users are assigned confidential user 
identification and passwords.

10. A malware is a broad term used to describe all sorts of unwanted or malicious code.  

III.		 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. Computer “virus” is a program which is developed by humans whose malicious  
intents is to disrupt the normal activity that can be done using a computer. T

2. A virus can spread if you are using an infected media like Pen drives, CD, DVD, etc,  
which may have itself got infected from some other computer.  T

3. Worms are usually parasitic in nature.  F
4. Macro viruses infects files with .exe extension.  F
5. Privacy is used to verify that a user sending a message is who he or she claims  

to be, and to provide the receiver with the means to encode a reply.  F
6. Identity protection refers to the protection of personally identifiable information.  T
7. Confidentiality of information is is defined as information to which you do  

not have general access.  T
8. Cyber safety refers to safe and responsible use of Information and Communication  

Technologies (ICT).  T
9. Facebook is a malware.  F
10. Polymorphic viruses have the capability of changing itself after infecting a computer.  T

IV.		 Short	Answer	Type	Questions	(SA-I)

1. What	are	blogs?

Ans.	A blog is a regularly updated website or web page, typically one run by an individual or small 
group, that is written in an informal or conversational style.

2. What	does	https	stand	for?

Ans.	 Hyper Text Transfer Protocol Secured.

3. What	is	the	feature	of	private	browsing	called	in	Chrome	browser?

Ans.	 Incognito

4. What	is	Log	off	in	Social	Networking?

Ans.	 Log off refers to closing the current session in the social networking site.

5. What	is	Cyberstalking?

Ans.	 Cyberstalking is a crime in which the attacker harasses a victim using electronic communication, 
such as e-mail or instant messaging (IM), or messages posted to a social networking site and chat 
site. A cyberstalker, using anonymity allow them to stalk their victim without being detected. 
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V.		 Short	Answer	Type	Questions	(SA-II)

1. State	two	methods	by	which	you	can	detect	a	virus.	

Ans.	 Following are some of the ways your computer reacts to viruses:

 • The speed of your computer may go down to a considerable extent.

 • Certain software may require more time to start than it does usually.

 • Certain software may not start at all.

 • Some software may start normally but closes down abruptly.

2. Name	the	three	type	of	information	collected	by	a	social	networking	site.

Ans.	 They are

 • Required	Information: Name, E-Mail, Date of Birth, Location. (Essential for the account.)

 •  Secret	Information: Alternate e-mail, mobile phone number, security question and answer.  
(In case the account is compromised or you have lost your password.)

 •  Biographical	Information: Information about yourself submitted voluntarily.  (For advertisement 
content offered to you and to aid in advertisement targeting.) .

3. State	three	points	that	you	should	remember	while	selecting	a	password.

Ans.	 While selecting passwords the following points are to be remembered:

 •  The longer the password, the harder it is to crack. Consider a 12-character password or longer.   

 •  Avoid names, places, and dictionary words.

 •  Mix it up. Use variations on capitalization, spelling, numbers, and punctuation.

 •  You may also use a specialized Password Manager package; as ultimately the number of 
passwords that you need to remember will grow.

4. What	is	Pharming?

Ans.	 Pharming refers to the fraudulent practice of directing Internet users to a bogus website that 
mimics the appearance of a legitimate one, in order to obtain personal information such as 
passwords, account numbers, etc.

5. List	two	methods	by	which	you	will	be	able	to	identify	malicious	websites.

Ans.	 The following are the list of malicious, criminal or inappropriate websites:

 •  Check for presence of an address, phone number and/or email contact – often indications that 
the website is genuine. If in doubt, send an email or call to establish authenticity.

 •  Check that the website’s address seems to be genuine by looking for subtle misspellings, extra 
words, characters or numbers or a completely different name from that you would expect the 
business to have.

 •  Roll your mouse pointer over a link to reveal its true destination, displayed in the bottom left 
corner of your browser. Beware if this is different from what is displayed in the text of the link 
from either another website or an email.
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VI.		 Long	Answer	Type	Questions	(LA)

1. Give	four	methods	of	identifying	malicious	sites.

Ans.	 The following are the list of malicious, criminal or inappropriate websites:
 •  Check for presence of an address, phone number and/or email contact – often indications that 

the website is genuine. If in doubt, send an email or call to establish authenticity.
 •  Check that the website’s address seems to be genuine by looking for subtle misspellings, extra 

words, characters or numbers or a completely different name from that you would expect the 
business to have.

 •  Roll your mouse pointer over a link to reveal its true destination, displayed in the bottom left 
corner of your browser. Beware if this is different from what is displayed in the text of the link 
from either another website or an email.

 •  If there is no padlock in the browser window or ‘https://’ at the beginning of the web address 
to signify that it is using a secure link, do not enter personal information on the site. 

 •  Websites which request more personal information than you would normally expect to give, 
such as user name, password or other security details IN full, are probably malicious.

2. Give	four	methods	by	which	you	will	be	able	to	safely	use	a	social	networking	site.

Ans.	 The following list should be followed for using the social networking safely: 
 • Use a strong password.  The longer it is, the more secure it will be.
 •  Use a different password for each of your social networking accounts and try changing it 

frequently.
 • Set up your security answers which available with social networking sites.

 • If you have social networking app on your phone, be sure to password protect your device.

3. What	do	you	understand	by	Identity	protection?		Give	three	steps	you	should	take	to	protect	
from	theft.

Ans.	 Identity protection refers to the protection of personally identifiable information, such as Aadhar 
Card Number, Credit/Debit Card Number, bank account number, username or password by an 
imposter in order to impersonate someone else.   Identity fraud can be used to obtain credit, 
merchandise and services in the name of the victim, or to provide the thief with false credentials. 
In addition to running up debt, in rare cases, an imposter might provide false identification to 
police, creating a criminal record or leaving outstanding arrest warrants for the person whose 
identity has been stolen.

 Some of the steps you should take to protect your identity from theft are:

 1.  Protect your computer and smartphone with strong, up-to-date security/anti-malware 
software. This is because if your computer or phone is infected with malicious software, other 
safeguards will be of little help.

 2.  The Operating System should also be regularly updated with different security patches and 
service packs as this will decrease the possibility of the security breach.
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 You should be able to spot spam and scams. Although some phishing scams are easy to identify, 
other phishing attempts in email, Instant Messaging, on social networking sites, or websites can 
look very legitimate. You should never click on a link that has been sent to you, if you have no 
idea about the source.  

4. What	is	the	method	of	selecting	a	strong	password?

Ans.	 While selecting passwords the following points are to be remembered:

 • The longer the password, the harder it is to crack. Consider a 12-character password or longer.   

 • Avoid names, places, and dictionary words.

 • Mix it up. Use variations on capitalization, spelling, numbers, and punctuation.

 •  You may also use a specialized Password Manager package; as ultimately the number of 
passwords that you need to remember will grow.  

5. What	do	you	understand	by	confidentiality	of	information?		State	the	best	practices	to	ensure	
confidentiality.

Ans.	 Confidentiality of information is defined as information to which the public does not have 
general access. This policy governs the use or further disclosure of such information.

 Best practices used to ensure confidentiality are as follows:

 •  An authentication process, which ensures that authorized users are assigned confidential user 
identification and passwords. Another type of authentication is biometrics.

 •  Role-based security methods may be employed to ensure user or viewer authorization. For 
example, data access levels may be assigned to specified department staff.

 •   Access controls ensure that user actions remain within their roles. For example, if a user is 
authorized to read but not write data, defined system controls may be integrated.

Application	based	Questions

1. To	use	the	internet	safely,	Suresh	has	been	given	a	questionnaire	consisting	of	5	questions.		
Help	him	with	the	questionnaire.

 a. When you are making up a user name for email and instant messaging, you should: 

  i. Always use your real name.

  ii. Use a name that does NOT reveal your true identity.

  iii. Use a name that gives good clues about who you really are. 

Ans.	 ii. Use a name that does NOT reveal your true identity.

 b. With your secret codes and passwords, you should: 

  i. Give them out to only your best friends.

  ii. Give them out to strangers.

  iii. Never give out your passwords, except to your parents. 

Ans.	 iii. Never give out your passwords, except to your parents.
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 c.  When someone asks for personal information like phone numbers or addresses online, you 
should: 

  i. Give the information to anyone who asks because it’s the polite thing to do. 

  ii. Post the information on any public Web site like MySpace, so anyone can find it.

  iii.  Never give out personal information online in emails or instant messages because you 
never know who you are really communicating with. 

Ans.	 iii.  Never give out personal information online in emails or instant messages because you never 
know who you are really communicating with.

 d. When you are filling out forms or surveys online, you should: 

  i. Answer all the questions truthfully.

  ii. Before you answer any questions, you should get your parents’ approval.

  iii. Make up funny answers to all the questions. 

Ans.	 ii. Before you answer any questions, you should get your parents’ approval.

2. Shobhit	felt	that	he	had	been	a	victim	of	cyberstalking	for	a	long	period	of	time.		Give	4	steps	
you	should	take	for	reporting	cybercrimes.

Ans.	 Here are few steps you should keep in mind for reporting cybercrimes:

 •  The first step is to register a written complaint to the immediate cyber cell in the city. The 
Information Technology Act categorically provides that a cyber crime has global jurisdiction, 
meaning that the crime may be reported in the Cyber Crime Units of any city, irrespective 
of the place where the act was committed. At the time of filing of the complaint, the person 
reporting the crime may also be required to provide their name, contact details and mailing 
address along with the application, which is to be addressed to the Head of the Cyber Crime 
Cell of the city. 

 •  In case of non-availability of cyber-cells in the city, one can file a F.I.R. in the local police 
station, commissioner or judicial magistrate of the city.

 •  Offences covered by the Indian Penal Code may also be reported at a local police station by 
lodging a First Information Report (FIR) irrespective of the jurisdiction in which the offence 
was committed. 

 •  A report should also be send to the administration of the website for them to take immediate 
steps.   Most social networking websites have a procedure in place for reporting any abusive 
activity or other such alleged offence. 

3. Mr	Swapan	wants	to	secure	his	profile	in	a	Social	Networking	site.		To	do	this,	he	needs	to	
change	some	privacy	settings	of	his	profile	in	the	social	Networking	site.		Suggest	some	privacy	
settings	that	will	safe	guard	his	identity.

Ans.	 Some of the common privacy settings associated with social networking sites are:

 •  The default privacy settings is “Public” , which may also be “Friends” or  “Custom.  The first 
two options are good for someone who has a small group of friends they don’t mind sharing 
everything with or who has no personal identifying information on their profile and doesn’t 
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mind it all being public.  But for those of us who want a little more control over exactly who 
sees what on our profiles, it’s time to familiarize yourself with the “Custom” option. 

 •  How You Connect– This section allows you to change how people find you, who can post to 
your wall and who sees what information on your wall.

 •  How Tags Work– This option controls who can tag you in pictures, you can see the pictures 
you’re tagged in and who can tag people in the pictures that you post. By default, Facebook 
shows the pictures you are tagged in publicly, even if you do not have a public wall.

 •  Apps and Websites–  This section controls the third party apps that are allowed to access and 
interact with your profile without compromising it.

 •  Privacy of each post- This option is for convenience where each time you make a post, you can 
choose if that post is public, only to friends, only to you and more. You can even set it to show 
only to certain lists that you have.

4. Indranil	always	finds	his	password	 is	being	compromised	 in	his	social	networking	account.		
Suggest	him	suitable	ways	by	which,	he	will	be	able	create	a	strong	password.

Ans.	While selecting passwords the following points are to be remembered:

 • The longer the password, the harder it is to crack. Consider a 12-character password or longer.   

 • Avoid names, places, and dictionary words.

 • Mix it up. Use variations on capitalization, spelling, numbers, and punctuation.

 •  You may also use a specialized Password Manager package; as ultimately the number of 
passwords that you need to remember will grow.  
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I.	 Tick	(√)	the	correct	option.

1. Which among the following software is not used for Word Processing?

 a. OpenOffice Writer  b. Microsoft Word

 c. Adobe PageMaker  d. Microsoft Excel
Ans.	 d. Microsoft Excel

2. Which group of the Home Tab allows you to change the font colour?

 a. Clipboard  b. Font

 c. Paragraph  d. Styles
Ans.	 b.  Font

3. Which among the following buttons allows you to change Line and Paragraph Spacing?

 a.   b. 

 c.   d. 

Ans.	 c.  

4. Which of the following is not a Font Style?

 a. Bold   b. Italics

 c. Underline  d. Capital
Ans.		 d. Capital

5. Which among the following group of the Home Tab allows you to make a text bold?

 a. Clipboard  b. Font

 c. Paragraph  d. Styles
Ans.		 b.  Font

6. Which among the following button is used to change the font colour of a text?

 a.   b. 

 c.   d. 

Ans.	 a.  

7. Which among the following button is used to change the background colour of a text?

 a.   b. 

 c.   d. 

Ans.	 b  

Word Processing using  
Microsoft Word 2016

Chapter 7
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8. The _________________ alignment aligns selected text to both right and left margin.

 a. Left Alignment  b. Right Alignment

 c. Centered Alignment  d. Justified Alignment

Ans.	 d. Justified Alignment

9. Which among the following Tab is used to add a Header and/or Footer?

 a. Home  b. Insert

 c. Design  d. Layout

Ans.		 b. Insert

10.  What is the default font in Word?

 a. Calibri  b. Times New Roman

 c. Bookman  d. None of these

Ans.	 a. Calibri

II.	 Fill	in	the	blanks	with	the	given	words.

1. Document1 is the default name for a Word document.

2. The Save	As of the File menu allows you to make a copy of the current document.

3. To type in a series of capital letters the Caps	Lock on the keyboard should be pressed.

4. Font	Face is a set of characters, including letters, numbers, symbols and punctuators.

5. To Save and Open a Word document the File Tab is used.

6. The Backspace key on the keyboard is used to remove a character on the left of the cursor and 
Delete key is used to remove a character on the right of the cursor.

7. Calibri is the default font in Word 2016.

8. Left alignment is the default alignment in Word.

9. The default line spacing in Word is 1.15.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. You can press the Enter key on the keyboard to mark the end of a paragraph. T
2. The default file extension of a Word file is .docx. T
3. It is possible to change the amount of space to leave between the lines of text. T
4. The Multiple Line Spacing option allows you to choose how many points of spacing  

you want between the lines. T
5. Headers are text and/or graphics that are repeated on the top of every page. T
6. Page Number cannot be added as header in a page. F
7. The New, Open and Save option is present in the Home Tab. F
8. Font is a specific form of typeface and is a typeface of one size and style. T
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9. Word 2016 do not have a Title bar. F
10. You cannot have Justify alignment of a paragragh.  F

IV.	 	Short	Answer	Type	Questions	(SA-I)

1. What	is	a	font?

Ans.	 A font is a graphical representation of text that may include a different typeface, point size, 
weight, color, or design.

2. What	are	the	different	types	of	alignments	in	Word?

Ans.	 Align Left, Justify, Align Right and Center.

3. What	is	a	footer	work	space?

Ans.	 The amount of space allocated for the footer section of a page is called footer work space.

4. What	is	the	file	extension	of	Word	document?

Ans.	 The default extension is docx.

5. What	is	paragraph	spacing?

Ans.	 The spacing that can be adjusted before and after paragraphs is called paragraph spacing.

V.	 Short	Answer	Type	Questions	(SA-II)

1. State	the	difference	between	a	header	and	a	footer.

Ans.		 A header is text that appears within the top margin on each page of a document or section. A 
footer appears in the bottom margin of each page

2. How	do	you	highlight	a	text	in	Word?

Ans.		 To highlight a text in word the following steps are involved:

 1. Select the txt.
 2. Click on the ‘Highlight’ drop-down list of the ‘Font’ group of the ‘Home’ Tab. 

3.  Name	any	two	options	of	‘Paragraph	Spacing’.

Ans.	 The two options of the ‘Paragraph Spacing’ are:

 •  Exactly: When you choose this option, the line spacing is measured in points, just like font size. 
For example, if you’re using 12-point text, you could use 15-point spacing.

 •  At least: Like the Exactly option, this lets you choose how many points of spacing you want. 
However, if you have different sizes of text on the same line, the spacing will expand to fit the 
larger text.

4. What	does	multiple	line	spacing	mean	in	Word?

Ans.		 The ‘Multiple’ line spacing allows you to type the number of lines of spacing you want. For 
example, choosing Multiple and changing the spacing to 1.2 will make the text slightly more 
spread out than single-spaced text. If you want the lines to be closer together, you can choose 
a smaller value, like 0.9.
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5. What	is	alignment?	Name	the	four	forms	of	alignment	in	Word.

Ans.	 Alignment refers to the position of lines in a paragraph in relation to the documents left and 
right margins.  The four forms of Alignment are Align Left, Justify, Align Right and Center.

VI.	 Long	Answer	Type	Questions	(LA)

1. Explain	the	process	of	inserting	a	header	and	a	footer	in	Word.

Ans.	 To insert a header or footer:

 1. Select the Insert tab.

 2. Click either the Header or Footer command. 

 3.  From the drop-down menu, select Blank to insert a blank header or footer, or choose one of 
the built-in options. 

 4.  The Design tab will appear on the Ribbon, and the header or footer will appear in the 
document.

2. Explain	the	any	three	line	spacing	in	a	paragraph.

Ans.	 Some of the options that you can change are:

 •  Exactly: When you choose this option, the line spacing is measured in points, just like font size. 
For example, if you’re using 12-point text, you could use 15-point spacing.

 •  At	least: Like the Exactly option, this lets you choose how many points of spacing you want. 
However, if you have different sizes of text on the same line, the spacing will expand to fit the 
larger text.

 •  Multiple: This option lets you type the number of lines of spacing you want. For example, 
choosing Multiple and changing the spacing to 1.2 will make the text slightly more spread out 
than single-spaced text. If you want the lines to be closer together, you can choose a smaller 
value, like 0.9.

3. How	do	you	save	a	file	in	Word?

Ans.	 To save a file:

 1. Locate and select the Save command on the Quick Access Toolbar.

 2. If you’re saving the file for the first time, the Save As pane will appear in Backstage view.

 3  You’ll then need to choose where to save the file and give it a file name. Click Browse to select 
a location on your computer. Alternatively, you can click OneDrive to save the file to your 
2OneDrive.

 4. The Save As dialog box will appear. Select the location where you want to save the document.

 5. Enter a file name for the document, then click Save.

 6.  The document will be saved. You can click the Save command again to save your changes as 
you modify the document.
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4. Discuss	the	steps	involved	in	paragraph	spacing	in	Word.

Ans.	 To change the paragraph spacing:

 1. Click the Home tab.

 2. In the Paragraph group, click the Line Spacing command button. A menu appears.

 3.  Choose a new line spacing value. The line spacing is set for the current paragraph or all 
selected paragraphs.

5. How	would	you	change	the	font	size	of	a	text	in	Word?

Ans.	 To change the Font size of a text in Word:

 1.  Select the text or cells with text you want to change. To select all text in a Word document, 
press Ctrl + A.

 2. On the Home tab, click the font size in the Font Size box.

Application	based	Questions

1. Rashid	while	typing	a	document,	usually	have	the	habit	of	using	the	Save	Button	on	the	Quick	
Access	Toolbar	to	store	the	document.		One	day	while	working	suddenly	he	does	not	find	the	
Save	Button.		Suggest	the	method	to	Rashid	so	that	he	can	again	use	the	Save	Button.

Ans.	 To add the Save button:

 1. Click Customize option of  the Quick Access Toolbar, and then click More Commands.

 2. In the Choose commands from list, click File Tab.

 3. Choose Save command, and then click Add.

 4. Remember to click OK.

2. Sujata		has	created	a	test	on	her	students	of	class	3	on	prepositions	in	Microsoft	Word.		She	
had	created	a	paragraph	as	shown	below:

 

Fill in	the	blanks	with	the	given	suitable	prepositions:

1.  I want to lose 5 kilogram ___________ (on, at, in) one month.

2.  Could you get me this pants _____________ (on, at, in) a larger 
size?

3.  She seems to be interested ___________ (on, at, in) Psychology.

4. I will come to pick you up ___________ (on, at, in) 2 pm tomorrow.

5.  This class will be held ___________  (on, at, in) Mondays.

 But the space (especially the height) given for each blank is too less for a child of class 3 to write.  
Suggest a method through which you will be able to help Sujata in increasing the space between 
the lines so that it helps the children in writing the prepositions comfortably.

Ans.		 Sujata can increase the line spacing between the lines using the following steps:
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 1. Select the paragraph you want to change.

 2. Select Home > Line and Paragraph Spacing, and choose the spacing you want.

3. Tripti	a	personal	assistant	at	Zimole	Corporation	Pvt.	Ltd.		She	had	typed	in	a	correspondence	
as	specified	by	her	boss,	but	due	to	hurry	she	had	typed	the	entire	letter	in	capital	letters.		
Help	her	in	converting	the	letter	to	lower	case,	with	the	first	alphabet	of	a	sentence	in	capital,	
without	retyping	the	entire	letter.

Ans.	 To change according to requirement:

 1. Click on the Home Tab.

 2. From the Font group use the ‘Change Case’ command options to change it to ‘Sentence case’.

4. Suzane	had	typed	her	English	project	entirely	in	Word.		She	now	wants	the	page	number	of	
each	page	to	be	displayed	at	the	bottom	of	every	page.		Suggest	her	the	process	to	do	so.

Ans.	 To insert page numbers:

 1. Double-click the header or the footer area (near the top or bottom of the page).

 2. On the Header & Footer, tab, click Field.

 3. In the Field names list, click Page, and then click OK.
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I.	 Tick	(√)	the	correct	option.

1. Grammatical errors are shown using ___________ wavy lines.

 a. Red   b. Blue

 c. Green   d. Purple

Ans.	 b. Blue

2.  Which Tab contains the Spelling & Grammar command?

 a. References   b. Layout

 c. Design   d. Review

Ans.	 d. Review

3.  Which group of the Review Tab contains the Spelling & Grammar command?

 a. Proofing   b. Insights

 c. Language   d. Comments

Ans.	 a. Proofing

4.  Which function key is used to start the Spelling & Grammar check?

 a. F5   b. F6

 c. F7   d. F8

Ans.	 c. F7

5.  Name the command that is used to provide synonyms for selected words ?

 a. Grammar.   b. Dictionary.

 c. Thesaurus.   d. None of these

Ans.	 c. Thesaurus

6.  The subscript and superscript command is present in which group of the Home Tab.

 a. Clipboard   b. Font

 c. Paragraph   d. Styles

Ans.	 b. Font

7.  Thesaurus allows you to choose a ___________________ for a given text.

 a. Antonyms   b. Synonyms

 c. Both a and b   d. Neither a nor b

Ans.	 b. Synonyms

Advance Formatting in 
Word 2016

Chapter 8
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8. Which Tab contains the Symbol command?

 a. Home  b. Insert

 c. Design   d. Layout

Ans.	 b. Insert

9.  In printing what is the term that refers to the gathering and arranging of individual sheets or 
other printed components into a pre-determined sequence?

 a. Print Preview  b. Page Preview

 c. Collate  d. Print

Ans.		 c. Collate

10.  Which group of the Insert Tab contains the Pictures command?

 a. Tables   b. Illustrations

 c. Add-Ins   d. Header & Footer

Ans.	 b. Illustrations

11.  What are the different type of page orientation in Word?

 a. Landscape  b. Portrait

 c. Both a and b  d. None of these

Ans.	 c. Both a and b

12. Which Tab contains the Orientation command?

 a. Home  b. Insert

 c. Layout  d. Design

Ans.	 c. Layout

13.  Which group of the Layout Tab allows you to change the Margins and Size of a Page?

 a. Page Setup  b. Paragraph

 c. Arrange  d. None of these

Ans.	 a. Page Setup

14. What is size of an A4 sized Paper?

 a. 8.5 “× 11”  b. 8.5 “× 14”

 c. 7.25 “× 10.5”  d. 8.27 “× 11.69”

Ans.	 d. 8.27” X 11.69”

15.  What are the different type of list possible in a Word Processor?

 a. Bullet  b. Numbering

 c. Both a and b  d.  None of these

Ans.	 c. Both a and b
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II.	 Fill	in	the	blanks	with	the	given	words.

1. The function key F7 is used to start with the Spelling & Grammar check..

2. A Bullet is a black circle used to highlight items in a list.

3. Word offers two page orientation options: landscape and portrait.

4. The Thesaurus command is present in the Review tab.

5. Superscript and subscript refer to the characters that are positioned slightly higher or slightly 
lower than the text on the line. 

6. The Symbol command is present  on the Insert Tab of the Symbols group.

7. A printout that you obtain on paper is called hardcopy.

8. Grammatical or punctuation mistakes in a document are shown in wavy blue underlines.

9. A Thesaurus is a book of group of words in groups of synonyms that have the same or nearly the 
same meaning.

10. You can insert images present in a file from the Insert Tab.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. It is not possible to insert pictures into a Word document external to Office. F
2. Grammatical mistakes are shown using red wavy underline. F
3. The Orientation command is present in the Page Setup group of the Home Tab. F
4. You cannot change the size of a page of a Word document. F
5. Numbering a list is required when a sequence needs to be followed. T
6. The Margins command is present in the Layout Tab. T
7. You can use Border and Shading to a text to produce emphasis. T
8. The Thesaurus command sometimes may not work in Word. F
9. Superscript are characters that are positioned slightly higher than the text on the line. T
10. The Symbol command is present  on the Insert Tab of the Symbols group.  T

IV.	 Short	Answer	Type	Questions	(SA	–	I)

1. How	are	Spelling	and	Grammatical	mistakes	shown	in	a	Word	document?

Ans.	 Spelling mistakes are shown as red wavy underlines and grammatical mistakes are shown using 
blue wavy underlines.

2. Which	group	and	Tab	contains	the	Thesaurus	command?

Ans.	 Tab-Review and Group-Proofing

3. What	is	the	keyboard	shortcut	for	subscript	and	superscript?

Ans.	 Superscript: Ctrl, Shift and +

 Subscript: Ctrl and =
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4. Which	group	and	Tab	contains	the	Symbol	command?

Ans.	 Tab:  Insert

 Group:  Symbol

5. What	are	Bullets?

Ans.	 Bullets In Word are used to add bullets in Microsoft Word to differentiate between the different 
points you want to make. The bulleted points form a list.

V.	 Short	Answer	Type	Questions	(SA	–	II)

1. State	the	difference	between	a	Subscript	and	a	Superscript.

Ans.	 A subscript or superscript is a character (number, letter or symbol) that is (respectively) set 
slightly below or above the normal line of type. It is usually smaller than the rest of the text. 
Subscripts appear at or below the baseline, while superscripts are above.

2. What	do	you	understand	by	the	‘Collate’	option	during	printing	a	document?

Ans.	 In printing, the term Collate refers to the gathering and arranging of individual sheets or other 
printed components into a pre-determined sequence. Basically, Collating creates consistent, 
logical sets from multiple parts.

3. What	do	you	understand	by	the	term	“Page	Setting”	in	Word?

Ans.	 Page settings refers to the parameters defined by the user that help determine how a printed page 
will appear. Those parameters can include everything from the size, margins, page orientation, 
to quality of print. More plainly, it’s a menu that allows users to customize the layout of a page.

4. What	is	a	Margin	in	Word?

Ans.	 A margin is the space between the text and the edge of your document. By default, a new 
document’s margins are set to Normal, which means it has a one-inch space between the text 
and each edge.

5. State	the	difference	between	Bullets	and	Numbering	in	Word.

Ans.	 Numbered lists are usually used when you need to put the headings under a specific order, 
ascending or descending. However, bullet points are used to get across your stuff fully in rather 
a chronological order without emphasis on any one point particularly.

6. What	do	you	understand	by	the	term	“Borders	and	Shading”?

Ans.	 Word’s options for borders in a document are moderately comprehensive and allow you to 
create a clear-cut layout or decorative design. You can apply borders to things like paragraphs, 
pages, table cells, etc.

VI.	 Long	Answer		Type	Questions	(LA)

1. State	the	process	of	performing	Spelling	and	Grammar	check	in	Word.

Ans.	 To start a check of the spelling and grammar in your file just press F7 or follow these steps:

 1. Click the Review tab on the ribbon. 



55 Computer Applications – IX (CBSE Course) Answers

 2. Click Spelling or Spelling & Grammar.

 3.  If the program finds spelling mistakes, a dialog box appears with the first misspelled word 
found by the spelling checker.

2. What	are	Symbols?		How	would	you	insert	symbols	into	a	document?

Ans.	 A symbol is a special character that is generally not found on the keyboard and therefore cannot 
be inserted directly into a document.  

 To insert such symbols:

 1. Place the cursor where you want the character to appear. 

 2. The Symbol command is present  on the Insert Tab of the Symbols group.

 3.  Click on the drop down list beside the Symbol command to see a dialog containing commonly 
used symbols. Click on a symbol to insert.

 4.  In case you want to see more symbol, click on the More Symbols… option to make the Symbol 
dialog box to appear. Click on a symbol you wish to insert, in order, then click on the Insert 
button. 

3. State	the	process	of	creating	a	Bulleted	List	in	Word.

Ans.	 To create a bulleted list:

 1.  Select the text you want to format as a list.

 2.  Click the drop-down arrow next to the Bullets command. A menu of bullet styles will appear.

 3.   Move the mouse over the various bullet styles. A live preview of the bullet style will appear 
in the document. Select the bullet style you want to use.

 4. The text will be formatted as a bulleted list.

4. Name	4	options	that	you	can	customize	before	printing	a	document.

Ans.	 Some of the options are: Pages, Print One sided, Collate, Page Orientation, Paper Size, Page 
Margins and Scaling.

5.  State	the	process	of	creating	a	border	around	a	paragraph.

Ans.	 1.  Click the Home tab and from the Paragraph group, click drop-down list of the  Borders button 
to display the Borders menu.

 2.  Choose the Borders and Shading command, which will make the Borders and Shading dialog 
box appear..

 3. Click on a relevant border style.

 4. To shade the selected paragraph click on the Shading Tab in the dialog. 

 5. Select a relevant colour or pattern for shading.

 6. Click on the OK button when done.
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Application	based	Questions

1. Arpita	a	primary	teacher	of	St.	Mary’s	School	at	Dehradun	is	preparing	a	comprehension	for	
her	 students.	 	She	prepared	a	comprehension	which	only	fills	half	 the	A4	size	paper	 (8.27	
inches	x	11.69inches).	 	Therefore	when	printed	a	 lot	of	paper	gets	wasted	 .	 	She	needs	 to	
repeat	the	entire	comprehension	in	the	second	half	without	rewriting	it,	so	that	she	can	tear	
off	the	paper	at	the	middle	and	distribute	each	half	to	two	students,	thus	saving	some	paper.		
Suggest	a	suitable	method	for	repeating	the	comprehension	for	Arpita.

Ans.		 Arpita can go for Copy-Paste method to repeat the entire comprehension without rewriting it 
entirely.

2. Sneha	while	typing	in	her	Geography	project	typed	the	names	of	the	planets	as	bulleted	list:

• Mercury

• Venus

• Earth

• Mars

• Jupiter

• Saturn

• Uranus

• Neptune

	 But	the	order	of	the	planets	should	be	maintained	according	to	the	distance	from	the	sun	
and	therefore	the	sequence	should	be	maintained.	 	This	 involves	the	 list	to	be	changed	to	
Numbered	list.		Suggest	the	method	by	which	you	will	be	able	to	change	the	above	Bulleted	
list	to	Numbered	list.

Ans.	 To change the list to Numbered List, select the entire bulleted list and press F12 on the keyboard 
to change the list to Numbered List.

3. Sunanda	wants	to	insert	an	image	into	a	document.		State	the	process	of	doing	it.

Ans.	 To insert a picture or a scanned image, follow these steps:

 1. Place the insertion point (cursor) where you want the image to appear.

 2. Select the Insert tab on the Ribbon, then click the Pictures command.

 3.  The Insert Picture dialog box will appear. Navigate to the folder where your image is located, 
then select the image and click Insert.

 4. The image will appear in the document.
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I.	 Tick	(√)	the	correct	option.

1. Which group of the Insert Tab is used to insert an equation in Word?

 a. Comments  b. Illustrations

 c. Text  d. Symbols

Ans.	 d. Symbols

2. Which group of the Insert Tab is used to insert shapes into a Word document?

 a. Comments  b. Illustrations

 c. Text  d. Symbols

Ans.	 b. Illustrations

3. Which Tab presents you with the New Comment command?

 a. Home  b. References

 c. Review  d. View

Ans.	 c. Review

4. It is a feature in Word that allows users to keep track of the changes a user makes or other users 
have made to a document.

 a. Track Changes  b. Note Changes

 c. Review Changes  d. Track Modifications

Ans.	 a. Track Changes

5. How many successive equal to symbols should you use to create a double line?

 a. 1  b. 2

 c. 3  d. 4

Ans.	 c. 3

6. In which Tab do you find the option to activate or deactivate the Autocorrect option?

 a. File  b. Home

 c. Insert  d. Design

Ans.	 a. File

7. Which among the following commands is not present in the ‘Comments’ group of the ‘Review’ Tab?

 a. Show Comments  b. Previous

 c. Delete  d. Hide

Ans.	 d. Hide

Advanced Features of 
Microsoft Word

Chapter 9
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8. It appears as letter(s) to denote relative position in a sequence.

 a. Ordinals  b. Cardinals

 c. Both a and b  d. None of these

Ans.	 a. Ordinals

9. Which option of the Insert Tab  do you find the way to insert a Mathematical Formula?

 a. Formula  b. Equation

 c. Image->Formula  d. Object->Formula

Ans.	 b. Equation

10. Which option of the left hand panel of the Word Options dialog allows Autocorrect Options?

 a. General  b. Display

 c. Proofing  d. Save

Ans.	 b. Proofing

II.	 Fill	in	the	blanks	with	the	given	words.

1. The Table command is present in the Insert Tab..

2. The Track Changes command of the Tracking group is present in the Review Tab.

3. Merge cells is used to break down the barriers between cells and join them into one cell.  

4.  Split cells is used to divide a single cell into several cells.

5. A table is a grid of cells arranged in rows and columns.  

6. Another way to merge and split cells is to click the Draw Table or Eraser command on the Table 
Tools Layout contextual tab of the Draw group.

7. AutoFormat controls some minor text formatting as you type.

8. Part of Word 2016’s AutoCorrect function is a feature named AutoFormat..

9. You can format a fraction by typing the first value in superscript, the slash mark, and then the 
second value in subscript.

10. When you turn on Track Changes, every change you make to the document will appear as a 
coloured markup.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. Track changes option allows you to take a print out of a document. F
2. Once a Table is inserted, you cannot insert additional rows. F
3. It is possible to delete a row by a right-click on any cell of the row for the desired option. T
4. Merge cells is used to break down the barriers between cells and join them into one cell. T
5. Split cells allows you to break a Table into 2 tables. F
6. Using ‘Draw Table’ command it is possible to merge a cell. F
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7. Using ‘Eraser’ command it is possible to split a cell. F
8. The AutoFormat option automatically detects and correct typos and misspelled words. T
9. You cannot insert mathematical symbols into a Word document. F
10. To create a bold line, type three underlines and press Enter. T

III.	 Short	Answer	Type	Questions	(SA-I)

1. What	are	tables	in	Word?

Ans.	 A table is a grid of rows and columns that intersect to form cells. The lines that mark the cell 
boundaries are called gridlines.

2. What	is	AutoFormat?

Ans.	 AutoFormat is a software feature that automatically changes the formatting or appearance of 
text.

3. What	is	split	cell	in	a	table?

Ans.	 The Split Cells feature allows you to split cells into two or more cells.

4. What	is	track	changes	option	in	Word	used	for?

Ans.	 The track changes is an editing command that is commonly used when you create an original 
document and make changes and want to keep track of the changes that are made to that 
original document.

5. Which	command	and	Tab	allows	you	to	insert	a	mathematical	formula	into	a	document?

Ans.	 Command- Equaltion

 Tab- Insert

IV.	 Short	Answer	Type	Questions	(SA-II)

1. Can	you	insert	a	row	into	a	table?		If	so,	how?

Ans.	 Yes. Click where you want in your table to add a row or column and then click the Layout tab 
(this is the tab next to the Table Design tab on the ribbon).

2. How	would	you	remove	a	column	in	a	table?

Ans.	 To remove a column

 1.  Select the row or column.

 2.  Right-click your mouse. A menu will appear.

 3.  Select Delete Cells. Selecting Delete Cells.

 4.  Select Delete entire row or Delete entire column, then click OK. Deleting a column.

3. State	the	process	of	creating	a	solid	line	and	double	line	using	the	AutoFormat	feature.

Ans.	 •  To create a double line, type three equal signs and press Enter.

 •  To create a bold line, type three underlines and press Enter.
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4. What	is	the	function	of	“Review	Comments”?		Name	the	group	of	the	Review	Tab	that	allows	
you	to	insert	comments	into	a	document.

Ans.	 Word 2016 also provides comments, which authors and reviewers often use to exchange ideas, 
ask for suggestions, or brainstorm during the review process. This is called ‘Review Comments”.

 Group-  Comments

5. What	is	the	function	of	the	shapes	tool	in	Word?

Ans.		 The Shapes Tool allow you allows you to create graphics, such as simple diagrams using 
rectangles, circles, lines, text, and other predefined shapes.  

V.	 Long	Answer	Type	Questions	(LA)

1. How	would	you	insert	a	table	in	Word?

Ans.	 To insert a blank table:

 1.  Place your insertion point in the document where you want the table to appear.

 2.  Select the Insert tab.

 3.  Click the Table command.

 4.   Hover your mouse over the diagram squares to select the number of columns and rows in the 
table. ... 

 5.  Click your mouse, and the table appears in the document.

2.  State	the	process	of	merging	cells	and	splitting	cells	in	Word.

Ans.	 To merge and split cells:

 Select the cells you want to merge or split, go to the Table Tools Layout contextual tab, and 
follow these instructions to merge or split cells:

 •   Merging	cells: Click the Merge Cells command (you can also right-click and choose Merge 
Cells) of the Merge group.

 •   Splitting	cells: Click the Split Cells button (you can also right-click and choose Split Cells) of the 
Merge group. In the Split Cells dialog box, declare how many columns and rows you want to 
split the cell into and then click OK.

3. State	the	process	of	activating	the	AutoFormat	dialog	box.

Ans.	 To activate the AutoFormat dialog:

 1.  Click the File tab, which brings the Backstage view.

 2.  Choose Options from the left hand panel.

 3.  The Word Options dialog box appears.

 4.  Select Proofing from the left side of the window. Click the button labeled AutoCorrect Options.

 5.  The AutoCorrect dialog box appears.  Click the AutoFormat as You Type tab.
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4. State	the	process	of	inserting	comments	in	Word.

Ans.		 If you want to add a comment on a word or paragraph, select it and then select the Review tab 
and click New Comment in the Comments group. 

 Your comments will then appear on the right side of the document, provided the Show Comments 
command is activated.  

5. State	the	process	of	tracking	changes	made	to	a	document.

Ans.	 	 Tracked changes are really just suggested changes. To become permanent, they must be 
accepted. On the other hand, the original author may disagree with some of the tracked changes 
and choose to reject them.

 To accept or reject changes:

 1.  Select the change you want to accept or reject.

 2.  From the Review tab, click the Accept or Reject command.

 3.   The markup will disappear, and Word will automatically jump to the next change. You can 
continue accepting or rejecting each change until you have reviewed all of them.

 4.  When you’re finished, click the Track Changes command once again to turn off Track Changes.

Lab	Exercise

1. Darpan is given a Table in Word as the following.   

Period-> 1st 2nd 3rd 4th

Monday English Drawing Maths
Tuesday EVS Maths Art and craft

Wednesday Gardening Singing Dancing English
Thursday English Maths Games

Merge	Cells

Split	Cells

 Mark the cells that are merged or split.
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2. Study	the	screenshot	below.	

 Top of Form

 

i.  Tessa’s supervisor has asked her to review the corrections he had made using the Track Change 
function, however, the changes are not visible.  How can Tessa view the changes he made?

 a. She can view the changes by changing the Display for Review value to All Markup.

 b. She can view the changes by selecting Show Markup in the Tracking group.

 c.  She can view the changes by switching on track changes by clicking on the Track Changes 
button in the Tracking group.

 d. There are no track changes made to this document.

Ans.	 b

ii. How do you insert a comment into a document?

 a. Right click and select Insert Comment then type your comment.

 b.  Under the Review tab on the Ribbon, in the Comments group, select New Comment then 
type your comment.

 c.  Under the Insert tab on the Ribbon, in the Comments group, select Comment then type your 
comment.

 d. All of the options listed above are correct.

Ans.		 b
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I.	 Tick	(√)	the	correct	option.

1. Which among the following is not an Animation Effect?

 a. Entrance  b. Emphasis

 c. Repeat  d. Motion Path

Ans.	 c. Repeat

2. Which of the following icon represents a PowerPoint pakage?

 a.   b. 

 c.   d. 

Ans.	 c.  

3. Which Tab contains the different view options of a presentation?

 a. File  b. Home

 c. View  d. Animations

Ans.	 c. View

4. Name the view that shows a thumbnail of each slide in order. 

 a. Normal View  b. Outline View

 c. Slide Sorter View  d. Reading View

Ans.		 c. Slide Sorter View

5. Maximum how many slides can you include in a page in a handout?

 a. 2  b. 4

 c. 6  d. 9

Ans.		 d.  9

6. Which command is used to insert a new slide into a presentation?

 a. New Slide  b. Fresh Slide

 c. Blank Slide  d. Title Slide

Ans.	 a. New Slide

Presentation Tool using 
PowerPoint 2016

Chapter 10
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7. Which among the following views allows you to give a thumbnail view of all the slides in a 
presentation?

 a. Normal View  b. Outline View

 c. Notes View  d. Slide Sorter View

Ans.		 d. Slide Sorter View

8. Name the group that contains the Format Background command.

 a. Themes  b. Variants

 c. Customize  d. Designer

Ans.	 c. Customize

9. Which among the following is not a fill style in Format Background panel?

 a. Solid fill  b. Gradient fill

 c. Pattern fill  d. Mixed fill

Ans.		 d. Mixed fill

10. Which among the following group contains the Header & Footer command?

 a. Slides  b. Tables

 c. Comments  d. Text

Ans.		 d. Text

II.	 Fill	in	the	blanks	with	the	given	words.

1. The 2 tabs of the Header and Footer dialog are Slide and Notes and Handouts. 

2. A small number before an animated object on a slide show that it has an animation along with 
the order of animation.

3. The Picture command of the Insert Tab is present in the Images group.

4. Animating slides involves adding movement and sometimes sound to text or to the slides in a 
presentation.

5. A layout is a design template that shows the arrangement of various objects over a slide.  

6. A Placeholder is a  box with a dotted outline, designed for the placement of different type of 
content on the slide.

7. The Entrance animation effect controls the way how an object enters the slide.

8. Exit animation effect controls the way how an object exits the slide.

9. The Animation Pane is present in the Animations Tab.

10. The Comparison layout is usually used for comparison between 2 items.  

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. You cannot have a blank slide layout in a presentation. F
2. Transitions is the animation effect that is produced when one slide moves to the next slide. T
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3. The Slide Show is the final result of a presentation, which may be displayed to  
a group of audience using an overhead projector.  T

4. The default extension of an Impress file is ..pptm. F
5. The   button may be used to save a presentation.  T
6. The Placeholder allows you to insert only images into a slide. F
7. A template is a predesigned presentation you can use to create a new slide show quickly.  T
8. Normal view is the view that shows a thumbnail of each slide in order. F
9. Handout view is the view that allows you to get a print-out of your slides for a handout.  T
10. The Text Box command of the Drawing group is used to insert text.  T

IV.	 Short	Answer	Type	Questions	(SA-I)

1. What	is	a	presentation?

Ans.		 A presentation software is a computer software package used to show information, normally in 
the form of a slide show. It mostly includes three major functions: an editor that allows text to 
be inserted and formatted, a method for inserting and manipulating graphic images and a slide-
show system to display the content.

2. What	is	a	Slide	Show?

Ans.	 A collection of pages arranged in sequence that contain text and images for presenting to an 
audience is called slide show.

3. What	is	a	slide	layout?

Ans.	 Slide layouts contain formatting, positioning, and placeholders for all of the content that appears 
on a slide. 

4. What	is	the	extension	of	a	presentation	file	in	PowerPoint?

Ans.	 .pptx

5. What	is	a	placeholder?

Ans.	 Placeholders are the containers in layouts that hold such content as text (including body text, 
bulleted lists, and titles), tables, charts, SmartArt graphics, movies, sounds, pictures, and clip art.

IV.	 Short	Answer	Type	Questions	(SA-II)

1. Name	the	basic	elements	of	a	slide.

Ans.	 Titles and sub-titles, Text, Shapes, Pictures, Audio/Video Clips and Transitions.

2. Name	the	four	fill	option	present	in	the	Format	Background	panel.

Ans.	 Solid fill, Gradient fill, Picture or Texture fill and Pattern fill.

3. What	is	the	difference	between	normal	view	and	slide	sorter	view?

Ans.	 Normal view is the view for creating individual slides.  This is the main/default view for formatting 
and designing slides by adding text, graphics, and animation effects
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 Slide Sorter view is the view that shows a thumbnail of each slide in order. Using this you may 
rearrange the order of slides, produce a timed slide show, or add transitions between selected 
slides.

4. What	do	you	understand	by	the	term	animation	in	a	slide?

Ans.	 Animating slides involves adding movement and sometimes sound to text or to the slides in a 
presentation.

5. In	your	own	words	explain	the	importance	of	“Rehearse	Timing”.

Ans.	 PowerPoint assists you in defining the right rehearse timings for automatic slide changes.  This is 
particularly important to know the display time for each slide, particularly when you are talking 
to an audience along with the slide.  

V.	 Long	Answer	Type	Questions	(LA)

1. Describe	the	different	slide	layouts	in	PowerPoint.

Ans.	 Section	Header: This layout is usually used to separate different sections of the same presentation, 
rather than use an additional Title slide.

 Two	Content: It consist of a placeholder to add title to the slide as well as placeholders for 2 
contents. The contents can be filled with bulleted text or different type of content may be added 
as mentioned in Title and Content layout.

 Comparison: It consist of a placeholder to add title to the slide as well as placeholders for 2 
contents.  This layout is usually used for comparison between 2 items.  You can also add different 
type of content as mentioned in Title and Content layout.

 Title	Only:  This layout contains a placeholder only to add a title at the top.  The remaining page 
is blank and therefore anything may be added.

 Blank:  This layout offers a blank slide, where you may add any element at any position according 
to choice.

 Content	with	Caption:  To insert some text as well as a caption, this layout is used.

 Picture	 with	 Caption: To insert a picture as well as a caption, select this slide layout. The 
slide contains a placeholder for inserting the picture on the right side of the slide as well as 
placeholders for inserting captions on the left side of the slide.

2. State	the	process	of	adding	a	background	to	a	group	of	slides.

Ans.	 To add a background to a slide or slides:

 1. Select the Design tab, then click the Format Background command of the Customize group.

 2.  The Format Background pane will appear on the right. Select the desired fill options. In our 
example, we’ll use a Solid fill with a light gold color.

 3. The background style of the selected slide will update.

 4.  If you want, you can click Apply to All to apply the same background style to all slides in your 
presentation.



67 Computer Applications – IX (CBSE Course) Answers

3. State	the	process	of	inserting	a	page	number	to	a	slide.

Ans.		 To Insert slide numbers or page numbers:

 1. On the View tab, click Normal.

 2. Click the Insert menu, and then click Slide Number.

 3.  The Header and Footer settings will open. Check the box next to Slide Number and enter 
the number you’d like to start your slide numbers with. The location of the slide number is 
highlighted in bold in the Preview area at the top of the settings box. 

 4.  (Optional) If you don’t want to number your title slide, make sure the box next to Don’t show 
on title slide is checked.

 5.  When you’re finished, if you want slide numbers on your entire presentation, click Apply to 
all. If you only want numbering on the slide or slides you have selected, click Apply.

4. State	the	process	of	animating	text	in	a	slide.

Ans.	 To apply animation to a text follow these steps:

 1.  Select the  text on the slide that you want to animate.

 2.  On the Animations tab of the ribbon, click Add Animation, and pick an animation effect.

5.  How	would	you	add	Footer	to	the	slides	of	a	presentation?

Ans.	 To Add a footer to a slide 

 1.  On the Insert tab, in the Text group, click Header & Footer.

 2.   In the Header and Footer dialog box, on the Slide tab, select the Footer check box, and then 
type the text that you want to appear in the center bottom of the slide.

 3.  Click on the OK button.

Application	based	Questions

1. Rimika	wants	to	ensure	that	there	is	consistency	in	design	and	colour	in	the	presentation	that	
she	is	making.		What	should	she	do	to	achieve	this?

Ans.		 She could use Slide /master View.  Slide Master view is a special feature in PowerPoint that 
allows you to quickly modify the slides and slide layouts in your presentation. From there, you 
can edit the slide master, which will affect every slide in the presentation. You can also modify 
individual slide layouts, which will change any slides using those layouts.

2. Kanan	wants	to	see	all	the	slides	in	her	presentation	simultaneously.	Suggest	which	view	she	
should	use	to	see	all	the	slides	simultaneously.

Ans.	 Slide Sorter View

3. Irene	doesn’t	know	the	meaning	of	the	following	animation	effect:
 a. Entrance  b. Motion Paths
 Explain the meaning of a) and b).

Ans.	 a. 	Entrance is an animation effect that controls the way how an object enters the slide. For 
example, in Bounce animation effect you will find an object “fall” onto the slide and then 
bounces several time.
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 b.  Motion	Paths: This animation effect ensures a predetermined path through which an object 
moves within the slide path.

4. Keerit	doesn’t	know	the	meaning	of	handouts.		Explain	the	meaning	of	handouts	to	him.

Ans.	 Handouts are documents you can print from within PowerPoint that include slide representations 
from your presentation. PowerPoint lets you include as many as 9 slides on each Handout page. 
Most Handouts are created to be printed, and the look and feel of these printed Handouts is 
determined by the Handout Master. To access and make edits to the Handout Master, you need 
to get to the Handout Master view in PowerPoint. Changes you make in this view influence the 
look and layout of printed Handouts.

5. Sunita	wants	to	create	a	presentation	on	“Global	Warming”.	 	State	at	 least	two	things	she	
should	prepare	first	for	creating	the	presentation.

Ans.	 Sunita needs  to take certain points in consideration, while preparing the presentation:

 •  Remember: A presentation is different than a paper.

 •  Resources of information is key to success.

 •  Logistics to be taken care of:

 •  Equipment Needs should also be taken care-of.
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I.	 Tick	(√)	the	correct	option.

1. Which among the following Microsoft Office package is a spreadsheet application?

 a. Word  b. Excel

 c. PowerPoint  d. Access

Ans.	 b. Excel

2. The default name for a Excel Workbook is ___________________.

 a. Workbook1  b. Worksheet1

 c. Sheet1  d. Book1

Ans.		 d. Book1

3. What is the total number of rows in a Excel Worksheet?

 a. 256  b. 1024

 c. 1048576  d. 1048578

Ans.		 c. 1048576

4. Which of the following constitutes a Cell Reference

 a. It is column name followed by a row number.

 b. It is row number followed by a column name.

 c. It is row number followed by a hyphen and a column name.

 d. It is column name followed by a hyphen and a row number.

Ans.	 a. It is column name followed by a row number.

5. A Cell range always has the ___________ symbol between the cell references.

 a. ; (semicolon)  b. . (fullstop)

 c. , (comma)  d. : (colon)

Ans.	 d. : (colon)

6. The cell which is currently being used is called ______________________.

 a. Current Cell  b. Active Cell

 c. Start Cell  d. Editing Cell

Ans.			 b. Active Cell

Introduction to 
Microsoft Excel 2016

Chapter 11
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7. Which of the following shows the reference to the Active Cell?

 a. Name Box  b. Active Box

 c. Both a and b  d. None of these

Ans.	a.	Name	Box

8. Which of the following function key is used for editing in a cell?

 a. F1  b. F2

 c. F3  d. F4

Ans.		 b. F2

9. The default extension of Excel file is ______________.

 a. .xlsx  b. .xld

 c. .xlm  d. .xlExcel

Ans.	 a. .xlsx

10. Which of the following comes under Horizontal Alignment

 a. Left Alignment  b. Right Alignment

 c. Center Alignment  d. All of these

Ans.		 d. All of these

II.	 Fill	in	the	blanks	with	the	given	words.		

1. In a cell you can have either a Horizontal or/and Vertical alignment.

2. To default name of an Excel workbook is Book1.

3. The XFD is the last column name in Excel.

4. A workbook is a file in which data in kept in worksheets.

5. Cell	reference refers to a location of a cell which is the column name followed by row number.  

6. Use the keyboard combination Ctrl+1 to activate Format Cells.

7. An intersection point of a row and a column is called a Cell.

8. By default text is aligned to the left and numbers are aligned to the right.

9. The Editing group of the Home Tab contains the Fill command.

10. Shift cells up option of the Delete dialog is used to fill the space produced by the deleted cell 
with the cell underneath it.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. The default name for a worksheet in Excel is Sheet1.  T
2. The address of a cell is referred by the row number followed by the column number.  F
3. You can have maximum 10000 rows in an Excel worksheet.  F
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4. An Excel worksheet there are maximum 1028 columns.  F
5. A cell range is used to represent a group of cells.  T
6. An Active Cell always have a thick border around it.  T
7. The Function Key F3 is used for direct cell editing.  F
8. It is not possible to select an entire worksheet at the click of a button.  F
9. The Name Box is used to show the address of the current selection or active cell in the  

form of Column and Row Headings.  T
10. The content of a row or column cannot be deleted.  F

IV.	 Short	Answer	Type	Questions	(SA-I)

1. What	is	the	last	row	heading	and	column	heading	in	Excel?

Ans.	 Last column heading: XFD
 Last row heading: 1048576

2. Which	Tab	host	the	New,	Save	and	Open	option	in	Excel?

Ans.	 File

3. Name	the	Toolbar	that	contains	the	‘Save’	button	in	Excel.

Ans.	 Quick Access Toolbar

4. What	is	the	alignment	by	default	in	Excel	for	Numbers	and	Text?

Ans.	 Numbers:Right Aligned

 Text: Left Aligned

5. State	the	difference	between	‘Shift	cells	up’	and	‘Entire	row’	option	used	with	deletion.

Ans.	 Shift cells up option to fill the space produced by the deleted cell with the cell underneath it.
 Entire rows option after selecting at least one cell, deletes the entire row from the sheet.

V.	 Short	Answer	Type	Questions	(SA-II)

1. State	the	difference	between	a	Worksheet	and	a	Workbook.

Ans.	 Excel Workbook is like a book that contains a number of pages while Excel Worksheet is a single 
page or sheet of a workbook like a page in a book. Linking two worksheets is more easy than 
linking two workbooks. Workbook is not a place where we manipulate with data.

2. What	is	a	cell	reference?		How	would	you	declare	a	cell	range	using	a	cell	reference?

Ans.	 A cell reference, or cell address, is an alphanumeric value used to identify a specific cell in a 
spreadsheet. Each cell reference contains one or more letters followed by a number. The letter 
or letters identify the column and the number represents the row.

 A cell range is a group or block of cells in a worksheet that has been selected or highlighted. 
When cells have been selected they are surrounded by an outline or border as shown in the 
image to the left.
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3. What	is	the	function	of	‘Autofill’?		Which	Tab	option	allows	you	to	fill	up	a	series	using	Autofill?

Ans.	 Autofill is a featurein Excel, that automatically fills certain boxes with data based on information 
the user has entered elsewhere.

 Home Tab

4. Name	the	three	methods	by	which	you	can	edit	the	contents	of	a	cell	in	Excel.

Ans.	 Replace Content Direct Cell Editing Formula bar Editing

5. Name	the	three	alignment	types	of:

 a. Horizontal Alignment b. Vertical Alignment

Ans.	 a. Left, Right and Center b. Top, Bottom and Middle

VI.	 Long	Answer	Type	Questions	(LA)

1. State	the	process	of	formatting	a	group	of	numbers	in	Excel,	so	that	it	displays	two	digits	after	
the	decimal.

Ans.	 The method involves the following steps:

 1. Select a cell or range of cells.

 2.  Right-click on the selected cells and from the popup menu that appears click on Format Cells… 
option.  This makes the Format Cells dialog open.

 3. Click on the Number tab and from the Category list click on Number.

 4.  Use the Decimal places box to specify the number of decimal places (e.g., if the number in the 
cell is 13.5 for 2 decimal places it displays 13.50, 3 decimal places would display 13.500).

 Click on Use 1000 Separator checkbox to specify the position of comma(,) in a given number.  

 5. Click the OK button.

2. State	the	process	of	formatting	the	appearance	of	Time	in	a	cell.

Ans.	 To Format the Appearance of Time in a Cell:

 1. Select the range of cells you want to format.

 2.  Right-click and click on the Format Cells option to activate the Format Cells dialog box and 
click on the Number Tab.

 3. Click Time in the Category  list box and select the desired time format from the Type: list box. 

 4. Click the OK button.

3. State	the	process	of	changing	the	font	colour	of	a	group	of	entries	in	Excel.

Ans.	 To change the font colour:

 1. Select a cell or range of cells.

 2.  From the  Font Colour drop-down list select the desired colour.   The default font colour in 
Excel is black.
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4. State	the	process	of	deleting	an	entire	row	in	Excel.

Ans.	 You can delete a row in a worksheet by a simple right click on the row heading and from the 
popup menu that appears click on the Delete option.  

5. Explain	the	following	options	of	the	Insert	dialog	in	Excel.

 a. Shift cells right  b. Shift cells down

 c. Entire row  d. Entire column

Ans.	 a. Shift cells right option to move the contents of the selected cell to the right when a cell is 
inserted.

 b.  Shift cells down option to move the contents of the selected cell downward when a cell is 
inserted.

 c. Entire row option to insert an entire row. The content of the original row is moved downward.

 d.  Entire column  option to insert an entire column. The content of the original column is shifted 
to the right.

Application	based	Questions

1. Naina	Sharma	wants	to	store	data	of	her	monthly	expenditure	for	a	period	of	one	year	and	
also	 wants	 to	 perform	 some	 calculations	 and	 analysis.	Which	 Office	 application,	 will	 you	
suggest	Naina	should	use	for	this	purpose?

Ans.	 Microsoft Excel

2.  Name	the	group	in	the	Home	Tab	that	has	all	the	options	of	changing	the	font	properties.

Ans.	 Font

3. Name	the	cells	included	in	the	range	reference	A1:B2.

Ans.	 A1,A2,B1 and B2.

4. What	will	be	the	cell	address	of	the	cell	formed	by	the	intersection	of:

 a. the fifth column and the eighth row?  b.  the ninth column and the eighth row?

Ans.	 a. E8 b. I8

5. How	would	you	refer	to	the	range	starting	from	1st	column,	1st	row	and	spread	till	4th	column	
and	5th	row?

Ans.	 A1:D5

6.  In	Excel,	what	is	the	column	immediately	next	to	column	“Z”?

Ans.	 AA

7. In	Cell	A1	a	certain	date	is	written	as	30/04/2015.		Suggest	a	method	by	which	you	can	make	
it	display	as	30	April	2015.

Ans.	 To change the date format in the A1 cell follow these steps:

 1. Select a cell or range of cells.
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 2.  Right-click and click on the Format Cells option to activate the Format Cells dialog box and 
click on the Number Tab.

 3. Click Date in the Category: list box and select the desired date format from the Type: list box.

 4. Click on the OK button.

8. Tarini	had	created	a	worksheet	that	looks	like	this:

	 As	you	can	see	that	column	B	containing	Names	are	overlapping	with	column	C.		What	should	
Tarini	do	so	that	the	names	are	completely	visible.

Ans.	 Tarini needs to resize the width of column ‘B’ to make the content of that column visible.  To 
resize the column the following actions need to be performed:

 a. Place your mouse pointer to the right edge of column B.

 b. The mouse pointer changes to the adjustment tool (double-headed arrow).

 c.  Drag the Adjustment tool to the right to desired width to make the entire content visible and 
release the mouse button.

9. Radhika	calculated	the	percentage	obtained	by	students	as	shown	Fig	A:

Fig	A Fig	B

 Because of incorrect formatting the decimal did not align with each other.  State the process by 
which she will be able to change it to Fig B.

Ans.	 1. Select a cell or range of cells.

 2.  Right-click on the selected cells and from the popup menu that appears click on Format Cells… 
option.  This makes the Format Cells dialog open.

 3. Click on the Number tab and from the Category list click on Number.

 4. Use the Decimal places box to specify 2 for the number of decimal places.

 5. Click the OK button.
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I.		 Tick	(√)	the	correct	option.

1.  Which among the following is the result when a cell contains an entry =7^3?

 a. 256   b. 343

 c. 341  d. None of these

Ans.		 b. 343

2.  Which among the following mathematical operators have the top most order of precedence?

 a. +   b. –

 c. ^    d. *

Ans.		 c. ^

3.  To add up the numbers in cell A1, A2, A3 and A4, which among the following is correct?

 a. =A1+A2+A3+A4   b. =SUM (A1;A2;A3;A4) 

 c. =SUM (A1:A4)   d. None of these

Ans.		 c. =SUM (A1:A4)  

4.  Which cell constitutes the 5th row and the 3rd column in a sheet?

 a. 5C   b. 5:3

 c. 3:5   d. C5

Ans.		 d. C5

5.  Which among the following symbols is used to represent an absolute cell reference?

 a. $  b. #

 c. %   d. @

Ans.		 a. $

6.  A formula =B$1 + C$3 + 5 in a cell D9 when copied to F12 will get the formula changed to  
_________________.

 a. =D1 + E3 +5   b. =B$2 +C$4+5

 c. =C$1+D$3+5  d. =D$1+E$3 +5

Ans.		 d. =D$1+E$3 +5

7.  A formula in a cell that directly/indirectly refers to its own cell is called _________________.

 a. Relative Reference   b. Absolute Reference

 c. Mixed Reference   d. Circular Reference

Ans.		 d. Circular Reference

Advance Features  
of Excel

Chapter 12
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8.   If the value in cell C3 contains 75 and the formula in cell D3 is =IF((C3>35);“Good”,“Bad”) what 
will it display in D3?

 a. Good   b. Bad

 c. C3>35   d. Err:532

Ans.	 a. Good  

9.  Which among the following charts show trends and variations in data over time using a line?

 a. Line Chart   b. Pie Chart

 c. XY Chart   d. Bar Chart

Ans.		 a. Line Chart

10.  What is the key in a chart called?

 a. Title   b. Answers

 c. Legend   d. Source

Ans.		 c. Legend

II.	 Fill	in	the	blanks	with	the	given	words.

1.  A Formula in Excel always begins with a ‘=’ (equal to) symbol.

2.  The kind of cell reference that remain same when copied to another cell is called Absolute Cell 
Referencing.

3.  The kind of cell reference that changes relative to its position same when copied to another cell 
is called Relative Cell Referencing.

4.  Mixed cell referencing is a combination of Relative and Absolute cell referencing.

5.  A formula in a cell that directly or indirectly refers to its own cell is called a Circular reference.

6.  A Pie chart displays the contribution of each value to the total.

7.  A XY chart is based on one data series consisting of a name, a list of x values and a list of y values.

8.  A Area chart shows values as points on the y axis with categories on the x-axis.

9.  A range of cells containing data that makes a chart is termed as Source data.

10.  The function MIN() is used to find the least among a group of values.

III.		 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. The LARGEST() function allows you to find the largest value in a range.  T
2. You cannot modify a chart after it is created.  F
3. <> is an arithmetic operator.  F
4. A Chart is a pictorial representation of data.  T
5. Excel allows you print selected sheets in a workbook. T
6. Circular Reference and Mixed Reference is same.  F
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7. In a hierarchy of operation in a mathematical expression, the calculation in parenthesis  
is always evaluated first.  T

8. Arguments in a function are separated by . (comma).  T
9. A Line Chart displays the contribution of each value to a total.  F
10. Data Series is the actual charted values of the source data.  T

IV.	 Short		Answer	Type	Questions	(SA-I)

1. What	is	absolute	cell	referencing?

Ans.	 An absolute cell reference is a cell reference in a spreadsheet application that remains constant 
even if the shape or size of the spreadsheet is changed, or the reference is copied or moved to 
another cell or sheet.

2. Which	operator	is	used	to	start	with	a	formula	or	function?

Ans.	 =

3. Give	a	cell	reference	as	an	example	for:

 a. Relative referencing  b. Mixed referencing

Ans.	 a. A1  b. $A$1

4. Give	the	general	syntax	of	the	IF	function	in	Excel.

Ans.	 The general syntax of the function is:

 =IF(Test , Then_value , Otherwise_value)

5. What	is	a	‘Data	Point’	in	a	chart?

Ans.		 It represents one value of the data series.

V.		 Short	Answer	Type	Questions	(SA-II)

1. What	are	the	different	mathematical	operators	and	their	use	in	Excel?

Ans.	 The different mathematical operators in Calc are:

 ^ for exponential (to the power of) e.g. 5^2 = 25 as 52=25

 + for addition

 - for subtraction

 * for multiplication

 / for division

2. What	are	the	three	types	of	cell	referencing?

Ans.		 Relative, Absolute and Mixed Referencing.

3. What	are	the	rules	for	using	a	function?

Ans.	 Rules for using a function:

 •  All functions begin with the = sign.
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 •  After the = sign define the function name (e.g., SUM, AVERAGE).

 •   One or more arguments-numbers, text or cell references-enclosed by parentheses. If there is 
more than one argument, separate each by a comma.

4. Explain	the	following	with	respect	to	charts:

 a. Chart Area b. Data Series c. Data Label

Ans.	 a.  The Chart area is the entire area that is reserved for accommodating a chart and other 
components like titles, legends, etc.

 b. Data Series is a collection of related values that are plotted on a chart.  

 c. It is some piece of text that is written near the Data Point to highlight some aspect of it.

5. What	is	the	difference	between	Line	chart	and	pie	chart?

Ans.		 A line chart shows trends and variations in data over time using a line. It displays a series of 
points that are connected over time.

 A pie chart displays the contribution of each value to the total. It is very useful to display information 
when you want to represent different parts of the whole, or the percentages of a total.

VI.		 Long	Answer	Type	Questions	(LA)

1. Explain	mixed	cell	referencing	with	an	example.

Ans.		 Mixed cell referencing is a combination of Relative and Absolute cell referencing. As with absolute 
cell references, the dollar sign ( $ ) is used in mixed cell references to indicate that a column 
letter or row number is to remain fixed when copied from one cell to another. Example $E4, 
F$6, etc. Note that for the cell reference $E4 the column letter is fixed while the row number 
is allowed to change when copied to other cells. For the cell reference F$6, the row number is 
fixed while the column letter changes.

2. Define	the	following	charts	in	Excel.

 a. Line Chart   b. Pie Chart

 c. Scatter Chart  d. Bar Chart

Ans.		 a.  A line chart shows trends and variations in data over time using a line. It displays a series of 
points that are connected over time.

 b.  A pie chart displays the contribution of each value to the total. It is very useful to display 
information when you want to represent different parts of the whole, or the percentages of 
a total.

 c.  Scatter charts are typically used for showing and comparing numeric values, like scientific, 
statistical, and engineering data.It combines x and y values into single data points and shows 
them in irregular intervals, or clusters. 

 d.  A bar chart is similar to a column chart except it uses horizontal bars instead of vertical bars 
it is also used to show variations in value over time.  This charts also allows us to compare 
values.
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3. Explain	the	use	of	the	following	with	respect	to	charts.

 a. Source Data  b. Axis

 c. Data Series  d. X-Axis

Ans.	 a. Source data are the values upon which a chart is created.

 b.  An axis on a chart or graph in Excel is a horizontal or vertical line containing units of measure. 
The axes border the plot area of column charts (bar graphs), line graphs, and other charts.

 c. Data Series is a collection of related values that are plotted on a chart.  

 d.  It is a horizontal line that shows variation another component of the chart.  Its length and 
segments represent different intervals of the values.

Application	based	Questions

1. Write	appropriate	formula	for	calculating	percentage	of	marks	of	a	student.	Marks	obtained	
are	given	in	the	cell	D8	and	maximum	marks	are	given	in	the	cell	D2.

Ans.	 =D8/D2*100

2. In	the	Excel	sheet	shown	below,	cell	A3,	B3	contain	numbers,	and	cell	C3	contains	a	formula.

 What will happen if

 a. Contents of cell A3 is changed to 5? b. Contents of cell B3 are deleted?

Ans.	 a. Cell C3 will display 8 instead of 5. b. Cell C3 will display 8 i.e. the value in A3.

3. Give	the	following	answers	with	respect	to	Excel:

 a.   Cell A1 contains the number 20 and B1 contains 3. What will be the contents of cell C1, if the 
formula =A1+B1*2^3  is entered in cell C1?

 b.   The contents of Cell A1, B1, C1 and D1 are 10, -20, 30 & -40 respectively. What will be the 
value displayed in cell E1 which contains the formula =MIN(A1:D1)

 c.   Cell D3 contains the formula =$B3 + C3  and this formula is copied to cell E3, what will be the 
copied formula in cell E3?

Ans.		 a. 44 b. -40 c. =$B3 + G3

4. NewStyle	Fashions	maintain	their	employee	salary	details	in	a	spreadsheet	as	shown	below.	
A	sample	data	of	7	employees	is	shown	below.	Write	formulas	for	the	operations	(a)	to	(c)	
and	answer	the	questions	based	on	the	spreadsheet	given	below	along	with	the	relevant	cell	
address:
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A B C D E F

1 NAME BASIC HRA DA PF NET SALARY

2 Surinder 50000 20000 ___ 600 ___

3 Kanika 56000 20000 ___ 600 ___

4 Aashish 35000 15000 ___ 400 ___

5 Harjit 45000 15000 ___ 500 ___

6 Abhijit 60000 25000 ___ 700 ___

7 Jyoti 75000 30000 ___ 700 ___

8 Amita 25000 10000 ___ 300 ___

9 Maximum Net Salary ___

 a. To calculate the DA as 25 % of BASIC+HRA for each employee and display in column D.

 b.  To calculate the NETSALARY as BASIC+HRA+DA–PF for each employee and display it  in 
column F. 

 c. To find the maximum NETSALARY and display in cell F9.

Ans.	 a.  In cell D2 you may use the formula as =25/100*(B2+C2) and copy the formula to the remaining 
cells in column D.

 b.  In cell F2 you may use the formula as =B2+C2+D2-E2  and copy the formula to the remaining 
cells in column F.

 c. In cell F9 the entry should be =MAX(F2:F8)

5. Give	the	following	answers	with	respect	to	Excel:

 a.   Kunal has stored the formula =MIN(C1:C5) in cell C6. How will the formula change when 
copied to cell D6.

Ans.		 =MIN(C2:C6)

 b.   If the values in the cells is as given A1 = 5, A2 = 10, A3 = 15 then to continue the series up to 
A20 which feature can we use?

Ans.		 Autofill

 c. The formula in cell A2 is =B2+C3. On copying this formula to cell C2, what will the formula be?

Ans.	 =D2+E3

 d.   The formula =A1+ $A$2 were entered in cell A3 and then copied into cell B3, what is the 
formula copied in to B3?

Ans.		 =B1+ $A$2

6. Tariq	 Fashions	maintain	 their	 employee	 salary	 details	 in	 Excel	 as	 shown	 below.	 A	 sample	
data	of	 7	employees	 is	 shown	below.	Write	 steps	 for	 the	operations	 (i)	 to	 (v)	 and	answer	
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the	questions	(vi)	to	(viii)	based	on	the	spreadsheet	given	below	along	with	the	relevant	cell	
address:

A B C D E F

1 NAME BASIC HRA DA PF NET SALARY

2 Surinder 50000 20000 ___ 600 ___

3 Kanika 56000 20000 ___ 600 ___

4 Aashish 35000 15000 ___ 400 ___

5 Harjit 45000 15000 ___ 500 ___

6 Abhijit 60000 25000 ___ 700 ___

7 Jyoti 75000 30000 ___ 700 ___

8 Amita 25000 10000 ___ 300 ___

9 Maximum ___

10 No. of Emp ___

i. To calculate the DA as 25 % of BASIC+HRA for each employee and display in column D.

Ans.	 In cell D2 you may use the formula as =25/100*(B2+C2) and copy the formula to the remaining 
cells in column D.

ii. To calculate the NETSALARY as BASIC+HRA+DA–PF for each employee and display in column F.

Ans.	 In cell F2 you may use the formula as =B2+C2+D2-E2  and copy the formula to the remaining 
cells in column F.

iii. To find the maximum NETSALARY and display in cell F9.

Ans.	 In cell F9 the entry should be =MAX(F2:F8)

iv. The manager inserts a column for S.No. in the above spreadsheet. Which feature will help him 
automate the typing of sequential numbers in this column?  

Ans.	 The Autofill handle is used to automate the typing of sequential numbers.

v. The manager wants to graphically represent a comparative analysis of the salaries of employees. 
Suggest the most suitable chart type for achieving the same.

Ans.	 He can go for Pie Chart for comparative analysis.

vi. If the Basic salary of an employee changes, will the manager have to redo all the calculations for 
that particular employee? Explain.

Ans.		 No the recalculation is not again required because the formula and functions that are given 
changes according to the values in the cells.



Computer Applications – IX (CBSE Course) Answers 82

I.	 Tick	(√)	the	correct	option.

1. Which among the following area in the Scratch window is used to show the output?

  a. Title Bar  b. Blocks Area

 c. Stage  d. Script Area
Ans.		 c. Stage

2. Which among the following is used to show the program or script for execution.
  a. Title Bar  b. Blocks Area
 c. Stage  d. Script Area
Ans.		 d. Script Area

3. Which button should be clicked to select a different sprite?
 a. Sprite Library  b. Sprite Button

 c. Backdrop Library  d. None of these
Ans.		 a. Sprite Library

4. Which among the following code block is used to remove all line traces?
 a. remove  b. delete

 c. clear  d. erase
Ans.		 c. clear

5. What are the Tabs present in a Scratch window?

 a. Scripts  b. Costumes

 c. Sounds  d. All of these
Ans.		 d. All of these

6. Which among the following will turn a sprite by 180 degree?

 a.  b. 

 c. Both a and b  d. None of these
Ans.	 c. Both a and b

7. Which among the following will turn sprite by 90 degree clockwise?

 a.  b. 

 c. Both a and b  d. None of these

Ans.		 a.  

Scratch Programming
Chapter 13
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8. Which among the following blocks in the Control script is used to create a block that executes 
continuously?

 a.   b. 

 c.   d. None of these

Ans.		 c. 

9. Which among the following script will make the pen ready for writing?

 a.   b. 

 c. Both a and b  d. None of these

Ans.		 a.  

10. What is the center coordinate of the XY plane

 a. (X=0, Y=0)  b. (X=0, Y=180)

 c. (X=-240, Y=0)  d. (X=0, Y=-240)

Ans.		 a. (X=0, Y=0)

II.		 Fill	in	the	blanks	with	the	given	words.

1. The Script area shows the code for execution.

2. The Stage shows the output of a script.

3. The Tabs present in the Blocks Area are Scripts, Costumes and Sounds.

4. The default filename in Scratch is Untitled.

5. To make the script say something you need to use the Looks block.

6. The Green flag is used to execute a script.

7. The default file extension of Scratch file is .sb2.

8. The code “wait 1 secs” is present in the Control block.

9. The Repeat code is used to execute a group of codes for specified number of times.

10. The scratch stage is 480 pixels wide and 360 pixels high.

III.	 State	whether	the	following	statements	are	True	(T)	or	(F)	False.

1. It is possible to select a different sprite other than a cat.  T
2. The green colour is associated with the Motion scripts.  F
3. The ‘clear’ command of the Pen script is used to remove all line traces.  T
4. The pen up command of the Pen script is used to trace a line with a moving object.  T
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5. The Sound script allows you to insert sound effects into your program.- T
6. The Scratch stage id 380 pixels high.  T
7. The Repeat block is used to execute infinitely.  F
8. The Backdrop library dialog allows you select different backgrounds for the stage.  T
9. Move 10 steps refers to moving 10 pixels.  T
10. The “next costume” code is present in the Looks Block.  T

IV.	 Short	Answer	Type	Questions	(SA-I)

1. What	is	a	program?

Ans.	 The step by step of writing instructions for the computer to perform is called a program.

2. Write	any	two	codes	of	the	Pen	Block.

Ans.	 clear  stamp

3. Which	code	block	is	used	to	repeat	execution	of	a	group	of	codes	infinitely?

Ans.	 forever

4. What	is	a	Sprite?

Ans.	 A Sprite is an object in Scratch which performs functions controlled by scripts.

5. What	block	contains	all	movement	of	a	Sprite?

Ans.	 Motion block

V.	 Short	Answer	Type	Questions	(SA-II)

1. Name	the	different	Tabs	of	the	Block	Area.

Ans.	 Scripts, Costumes and Sounds

2. What	is	the	function	of	the	Script	Area?

Ans.		 The Scripts Area is where scripts can be assembled. The Scripts Area is the area on the right side 
of the project editor where scripts are assembled. It can be accessed from both the Stage and 
from sprites, although the Stage and each sprite all have separate scripts areas and scripts.

3. What	is	a	Stage	in	Scratch?

Ans.	 The Stage is the term for the background of the project, but can have scripts, backdrops 
(costumes), and sounds, similar to a sprite. It has some restrictions of sprite functionality, such 
as motion and size blocks.

4. Name	the	menu	options	in	Scratch.

Ans.	 File, Edit, Tips and About

5. What	is	Backdrop	Library?

Ans.		 A backdrop is one out of possibly many frames, or backgrounds, of the Stage. It is located in the 
backdrops library.
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V.	 Long	Answer	Type	Questions	(SA-II)

1. How	do	we	execute	a	script	in	Scratch?

Ans.	 A Script may be executed by clicking on the “Green Flag” or clicking any where on the script.

2. State	the	process	of	selecting	a	new	sprite	in	Scratch.

Ans.		 1. From the Scripts Area click on Sprite Library button.

 2.   The Sprite Library dialog opens up.  From the Category panel select a category and from the 
right hand panel select a sprite and click on the OK button.

 3. The Stage Area now shows the selected sprite.  

3.  How	do	you	change	the	background	of	a	stage?

Ans.	 1. To change the background(which is white by default), click on backdrop button on the bottom 
left corner of the Scratch window.

 2.  This will present you with a library of backdrops.  Select any backdrop and click on the OK 
button.

 4. What is the function of the Motion Block?  State any 3 codes of the Motion Block.

 5. What is the significance of the command ‘if on edge, bounce’?

Application	Based	Questions

1. Sundaram	has	created	a	project	in	Scratch	but	does	not	know	how	to	save	it.		State	the	process	
of	saving	the	project	in	“projects”	folder	of	the	D	drive.

Ans.	 To save the project:

 1. Click on File->Save.

 2. Select the D drive.

 3. Select the “projects” folder

 4. Provide a name to the file.

 5. Click on OK button.

2. Ramen	wants		to	draw	a	rectangle	of	200	pixels	length	and	100	pixels	breadth.		Help	him	write	
the	code.

Ans.	
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3. Dinesh	wants	to	change	the	background	of	his	project	and	the	sprite.	 	State	the	process	of	
changing	the	background.		Also	state	the	process	of	changing	the	sprite.

Ans.		 Changing the background:

 1.  To change the background(which is white by default), click on backdrop button on the bottom 
left corner of the Scratch window.

 2.  This will present you with a library of backdrops.  Select any backdrop and click on the OK 
button.

 Changing	the	Sprite:

 1. From the Scripts Area click on Sprite Library button.

 2.  The Sprite Library dialog opens up.  From the Category panel select a category and from the 
right hand panel select a sprite and click on the OK button.

 3. The Stage Area now shows the selected sprite.  
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I.	 Tick	(√)	the	correct	option.

1. Which of the following language processor is used in Python?

 a. Interpreter  b. Compiler

 c. Both a and b  d. None of these

Ans.		 a. Interpreter

2. Which are the modes of programming in Python?

 a. Interactive Mode  b. Script Mode

 c. Both a and b  d. None of these

Ans.		 c. Both a and b

3. IDLE stands for ______________________________________________.

 a. Integrated Development Learning Environment.

 b. Integrated Deployment Learning Environment.

 c. Interactive Development Learning Environment.

 d. Integrated Development Learning Engineering.

Ans.		 a. Integrated Development Learning Environment.

4. Which statement in Python is used to display the output in the Shell window?

 a. print  b. display

 c. output  d. PRINT

Ans.		 a. print

5. Python strings are enclosed within quotes.

 a. Single  b. Double

 c. Both a and b  d. None of these

Ans.		 c. Both a and b

6. Which of the following symbol is used to insert comment in a program in Python?

 a. #  b. @

 c. !  d. ^

Ans.		 a. #

Introduction to Python
Chapter 14
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7. The statement print(“Hello” “World”) will display:

 a. HelloWorld  b. Hello World

 c. Hello World  d. HW

Ans.		 a. HelloWorld

8. Which of the following keyboard combination is used to start the script editor?

 a. Ctrl+S  b. Ctrl+O

 c. Ctrl+N  d. None of these

Ans.		 a. Ctrl+S

9. Which among the following function key is used to run a Python script?

 a. F1  b. F2

 c. F4  d. F5

Ans.		 d. F5

10. What does 15 % 2 evaluate to?

 a. 0  b. 1

 c. 2  d. 3

Ans.		 b. 1

II.	 Fill	in	the	blanks	with	the	given	words.

1. The print statement is used to display the output.

2. If a line begins with # it is completely Ignored by the interpreter.

3. Data	Type is a way of dictating Python what type of data will a variable hold.

4. Strings are enclosed within single or Double quotes.

5. Integers are numbers without a Point.

6. Integers, Float and Complex numbers are valid Python numerical types.

7. A variable is a name given to a memory location that can contain a data value.

8. The equal sign (=) is used to assign values to variables.

9. Variables may begin with an alphabet or Underscore.

10. Keywords are reserve words that have special meaning to the compiler.

III.	 State	whether	the	following	statements	are	True	(T)	or	False	(F).

1. You need to declare a variable before using it.  F
2. Keywords may be used as variables.  F
3. Arithmetic Operators are used to evaluate a mathematical expression. T
4. 25max is a valid variable.  F
5. You need to save a file before execution in Interactive mode.  F
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6. Python uses a compiler. F
7. Lines of comments are preceded with the & symbol.  F
8. The display( ) statement is used to print the output on the shell window.  F
9. You can program both in Interactive and Script Mode in Python.  T
10. Variables are names given to memory locations that stores data. T

VI.		 Short	Answer	Type	Questions	(SA-I)

1. Who	developed	Python?

Ans.		 Guido van Rossum

2. Name	any	numerical	data	type.

Ans.		 Integer

3. What	is	comment	used	for?

Ans	 A comment is a programmer-readable explanation or annotation in the source code of a 
computer program. They are added with the purpose of making the source code easier for 
humans to understand, and are generally ignored by compilers and interpreters.

4. Which	mode	is	used	to	save	a	program	for	future	use?

Ans.	 Script Mode

5. What	are	Arithmetic	Operators?

Ans.	 Arithmetic Operators are symbols used to perform arithmetic operations that include 
multiplication, division, addition and subtraction.

V.		 Short	Answer	Type	Questions	(SA-II)

1. What	are	the	two	modes	of	programming	in	Python?

Ans.		 Script Mode and Interactive Mode

2. Name	any	two	areas	where	Python	programs	are	used.

Ans.	 It has wide range of applications from Web development (like: Django and Bottle), scientific 
and mathematical computing (Orange, SymPy, NumPy) to desktop graphical user Interfaces 
(Pygame, Panda3D).

3. What	is	a	program?	Which	language	processor	is	used	by	Python?

Ans.	 A step-by-step instruction given to the computer to perform a particular job is called a program. 

 Python uses an interpreter to convert programs written using python syntax during execution.

4. What	is	Script	Mode?		What	is	the	default	extension	of	a	Python	file?

Ans.	 The Script Mode on the other hand allows you to type in instructions into a file, which is then 
used by the interpreter for execution of the instruction. Thus instead of having to run one line 
or block of code as in interactive mode you can type up all your code in one text file, or script, 
and run all the code at once. Such files should have the extension ‘.py’.  
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5. What	is	the	full	form	of	IDLE?		State	its	function.

Ans.		 IDLE:  Integrated Development Learning Environment.

 Python IDLE is a software suite that consolidates the basic tools developers need to write and 
test software. It contains a code editor, a interpreter and a debugger that the developer accesses 
through a single Graphical User Interface (GUI).  

VI.		 Long	Answer	Type	Questions	(LA)

1. State	the	process	of	starting	Python	IDLE.

Ans.	 To start the Python IDLE.

 1. Click on Start-> All apps of the Start Menu.

 2. Scroll down the list until you get Python 3.6. Click on it.

 3. It shows you a list of programs in a submenu.  Click on IDLE (Python 3.6 32-bit)

2. State	the	difference	between	Interactive	and	Script	Mode.

Ans.		 Interactive Mode is a command line shell which gives immediate result for each instruction, while 
running previously fed instructions in active memory.  As new lines are fed into the interpreter, 
the fed program is evaluated both in part and in whole.

 The Script Mode on the other hand allows you to type in instructions into a file, which is then 
used by the interpreter for execution of the instruction.  Thus instead of having to run one line 
or block of code as in interactive mode you can type up all your code in one text file, or script, 
and run all the code at once.

3. Give	any	two	aspect	of	the	print(	)	statement	in	Python.

Ans.	 The two aspects of print() statement are:

 •  The print( ) statement is used to display an output.

 •   In case you want to display a message, you need to enclose within quotes within the 
parenthesis. Any text enclosed within quotes is called a string.  A string may consist of letters, 
digits and/or symbols.  Thus print( ) statement is used to display a string.

4. What	is	a	Data	Type?		What	are	the	data	types	used	in	Python?

Ans.	 Data Type is a way of dictating Python what type of data will a variable hold.

5. Name	the	different	numerical	data	types	used	in	Python.

Ans.	 Python has five standard data types −

 •  Numbers

 •  String

 •  List

 •  Tuple

 •  Dictionary
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Application	based	Questions

1. Which	of	the	following	is	not	a	valid	variable	and	why?

 a. abc

Ans.	 valid

 b. 1abc

Ans.	 Not valid, as variable names cannot begin with a digit

 c. ab cd

Ans.	 Not valid, as variable names cannot have a blank space in between.

 d. s.i

Ans.	 Not valid, as dot is used.

 e. simple_interest

Ans.	 Valid

2. Which	among	the	following	is	not	a	valid	integer	and	why?

 a. 12.35

Ans.	 Invalid, as it contains a decimal point

 b. 12,345

Ans.	 Invalid, as it contains a comma.

 c. 12,345

Ans.	 Invalid, as it contains a comma.

 d. 12345

Ans.	 Valid

3. Correct	the	following	program	that	adds	up	2	integers	12	and	75	using	variables.		Underline	
each	correction.

Ans.	 a=12

 b=75

 c=a+b

 print(c)
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4. Give	the	output	of	the	following	program:

Ans.	 Output

 15  26  6.5  1  181.0

Lab	Activity

1. Write	a	program	to	find	the	sum	and	difference	between	25	and	16	using	variables	in	different	
lines.

Ans.	

2. Write	a	program	to	find	the	product	of	5,	7	and	12	using	variables.

Ans.	

3. Write	 a	 program	 to	 find	 the	 product	 of	 the	 sum	 and	 difference	 between	 17	 and	 2	 using	
variables.

Ans.	
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4. Write	a	program	to	find	the	average	of	36,45	and	53	using	variables	of	adequate	data	type.

Ans.	

5. Write	a	program	using	 variables	 to	find	 the	 sum	of	 three	numbers	 say	15,	 36	and	45	and	
subtract	the	result	from	100	using	variables.

Ans.	

6. Write	a	program	using	variables	to	find	the	area	and	perimeter	of	a	rectangle	of	length	12cm	
and	breadth	8cm.

Ans.	

7. Write	a	program	using	variables	to	find	the	profit	and	profit	percent	of	a	certain	transaction	
where	S.P.=₹	10000	and	C.P.=₹	7000.

Ans.	

8. Write	a	program	using	variables	to	find	the	cost	of	17	pencils	if	the	cost	of	one	pencil=₹	2.50.

 Output should be:

 Cost of 1 pencil=₹2.5

 Cost of 17 pencils=₹42.5
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Ans.	

9. Write	a	program	using	variables	to	find	the	area	and	circumference	of	a	circle	whose	radius	is	
12cm.

 Note that :

 Area of a circle= π r2

 Circumference of a circle = 2 π r

 Where r is the radius of the circle and π is 3.142.

Ans.	

10. Write	a	program	to	assign	5	and	6	to	variables	a	and	b	respectively	and	interchange	them.	
Thus	after	interchanging,	a	and	b	will	be	6	and	5	respectively.

Ans.	

11. Write	a	program	to	initialize	three	variables	a,	b	and	c	with	234,	456	and	712	and	store	the	
sum	of	the	last	digits	of	the	variables	into	d	and	display	it.

Ans.	


